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Safety Instruction  
 

 

Before using the product … 

 

For your safety and effective operation, please read the safety instructions thoroughly before using the product. 

 

► Safety Instructions should always be observed in order to prevent accident or risk with the safe and 

proper use the product. 

 

► Instructions are divided into “Warning” and “Caution”, and the meaning of the terms is as follows. 

 

This symbol indicates the possibility of serious injury or death if some applicable 

instruction is violated  

 

This symbol indicates the possibility of severe or slight injury, and property 

damages if some applicable instruction is violated 

 

Moreover, even classified events under its caution category may develop into serious accidents relying on 

situations. Therefore we strongly advise users to observe all precautions properly just like warnings. 

 

► The marks displayed on the product and in the user’s manual have the following meanings. 

Be careful! Danger may be expected. 

Be careful! Electric shock may occur. 

 

► The user’s manual even after read shall be kept available and accessible to 

 any user of the product. 

Warning 

Caution 
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Safety Instructions for design process 
 
 
 
 
 
 
 
 
 
 
 

 Please install a protection circuit on the exterior of PLC so that the whole system may 

operate safely regardless of failures from external power or PLC. Any abnormal output or 

operation from PLC may cause serious problems to safety in whole system.  

- Install protection units on the exterior of PLC like an interlock circuit that deals with opposite 

operations such as emergency stop, protection circuit, and forward/reverse rotation or install an 

interlock circuit that deals with high/low limit under its position controls. 

- If any system error (watch-dog timer error, module installation error, etc.) is detected during 

CPU operation in PLC, all output signals are designed to be turned off and stopped for safety. 

However, there are cases when output signals remain active due to device failures in Relay and 

TR which can’t be detected. Thus, you are recommended to install an addition circuit to monitor 

the output status for those critical outputs which may cause significant problems.  

 Never overload more than rated current of output module nor allow to have a short circuit. 

Over current for a long period time maycause a fire . 

 Never let the external power of the output circuit to be on earlier than PLC power, which may 

cause accidents from abnormal output oroperation. 

 Please install interlock circuits in the sequence program for safe operations in the system 

when exchange data with PLC or modify operation modes using a computer or other 

external equipments Read specific instructions thoroughly when conducting control operations 

with PLC.  

Warning 
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Safety Instructions for design process 
 
 
 
 
 
 
 
 

 
Safety Instructions on installation process 

 I/O signal or communication line shall be wired at least 100mm away from a high-voltage 

cable or power line. Fail to follow this 

       

Caution 
    

 Use PLC only in the environment specified in PLC manual or general standard of data 

sheet. If not, electric shock, fire, abnormal operation of the product may be caused. 

 Before install or remove the module, be sure PLC power is off. If not, electric shock or damage 

on the product may be caused. 

 Be sure that every module is securely attached after adding a module or an extension 

connector. If the product is installed loosely or incorrectly, abnormal operation, error or dropping 

may be caused. In addition, contact failures under poor cable installation will be causing 

malfunctions as well. 

 Be sure that screws get tighten securely under vibrating environments. Fail to do so will put 

the product under direct vibrations which will cause electric shock, fire and abnormal operation. 

 Do not come in contact with conducting parts in each module, which may cause electric 

shock, malfunctions or abnormal operation. 

Caution 
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Safety Instructions for wiring process 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Prior to wiring works, make sure that every power is turned off. If not, electric shock or 

damage on the product may be caused. 

 After wiring process is done, make sure that terminal covers are installed properly before 

its use. Fail to install the cover may cause electric shocks. 

Warning 

 Check rated voltages and terminal arrangements in each product prior to its wiring 

process. Applying incorrect voltages other than rated voltages and misarrangement among 

terminals may cause fire or malfunctions. 

 Secure terminal screws tightly applying with specified torque. If the screws get loose, short 

circuit, fire or abnormal operation may be caused. Securing screws too tightly will cause 

damages to the module or malfunctions, short circuit, and dropping. 

 Be sure to earth to the ground using Class 3 wires for FG terminals which is exclusively 

used for PLC. If the terminals not grounded correctly, abnormal operation or electric shock 

may be caused. 

 Don’t let any foreign materials such as wiring waste inside the module while wiring, 

which may cause fire, damage on the product or abnormal operation. 

 Make sure that pressed terminals get tighten following the specified torque. External 

connector type shall be pressed or soldered using proper equipments.  

Caution 
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Safety Instructions for test-operation and maintenance 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 
 
 
 

 Don’t touch the terminal when powered. Electric shock or abnormal operation may occur. 

 Prior to cleaning or tightening the terminal screws, let all the external power off including 

PLC power. If not, electric shock or abnormal operation may occur. 

 Don’t let the battery recharged, disassembled, heated, short or soldered. Heat, explosion 

or ignition may cause injuries or fire. 

Warning 

 Do not make modifications or disassemble each module. Fire, electric shock or abnormal 

operation may occur. 

  Prior to installing or disassembling the module, let all the external power off including 

PLC power. If not, electric shock or abnormal operation may occur. 

 Keep any wireless equipment such as walkie-talkie or cell phones at least 30cm away 

from PLC. If not, abnormal operation may be caused. 

 When making a modification on programs or using run to modify functions under PLC 

operations, read and comprehend all contents in the manual fully. Mismanagement will 

cause damages to products and accidents. 

 Avoid any physical impact to the battery and prevent it from dropping as well. Damages 

to battery may cause leakage from its fluid. When battery was dropped or exposed under strong 

impact, never reuse the battery again. Moreover skilled workers are needed when exchanging 

batteries.  

Caution 
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Safety Instructions for waste disposal 
 

 Product or battery waste shall be processed as industrial waste. The waste may discharge 

toxic materials or explode itself. 

Caution 
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                                                         About User’s Manual 

 

 

About User’s Manual 
 

Congratulations on purchasing PLC of LSIS Co., Ltd. 

Before use, make sure to carefully read and understand the User’s Manual about the functions, 

performances, installation and programming of the product you purchased in order for correct use and 

importantly, let the end user and maintenance administrator to be provided with the User’s Manual.  

 

The User’s Manual describes the product. If necessary, you may refer to the following description and order 

accordingly. In addition, you may connect our website (http://www.lsis.biz/) and download the information as 

a PDF file.  

 

Relevant User’s Manuals 

Title Description 
No. of User’s 

Manual 

XG5000 User’s 
Manual 

It describes how to use XG5000 software especially about online 
functions such as programming, printing, monitoring and 
debugging by using XGT series products. 

10310000512 

XG5000 User’s 
Manual 

It describes how to use XG5000 software especially about online 
functions such as programming, printing, monitoring and 
debugging by using XGB(IEC) 

10130000834 

XGK/XGB Series 
Instruction 

It describes how to use the instructions for programming using 
XGK/XGB series. 10310000510 

XGI/XGR/XEC 
Series Instruction 

It describes how to use the instructions for programming using 
XGB(IEC) series. 10130000833 

XGB Hardware  
User’s Manual 

It describes how to use the specification of power/input 
/output/expansion modules, system configuration and built-in 
High-speed counter for XGB basic unit. 

10310000926 

XGB Hardware 
User’s Manual (IEC) 

It describes how to use the specification of power/input 
/output/expansion modules, system configuration and built-in 
High-speed counter for XGB basic unit. 

10130001059 

XGB Analog 
User’s Manual 

It describes how to use the specification of analog input/analog 
output/temperature input module, system configuration and built-
in PID control for XGB basic unit. 

10310000920 

XGB Position 
User’s Manual It describes how to use built-in positioning function for XGB unit. 10310000927 

 
 

http://www.lsis.biz/
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Chapter 1 Overview 
 

1.1  Introduction 
This user manual describes the CANopen I/F module (hereinafter, CANopen module) of XGB PLC system 
network. The CANopen network is an open-type network used for industrial control devices. It is driven by 
CiA (CAN in Automation) and supported by more than 400 companies across the world. On the CAN 
(Controller Area Network) standard, the application protocol CANopen is built in, and is defined as an 
international standard.  
The transmission method is CSMA/BA (Carrier Sense Multiple Access/Bitwise Arbitration) and all the stations on the 
network can send messages whenever the network is in ‘free’ state. If multiple stations desire to send messages, the 
station having the highest priority has the right to send its message.  
 

In the programming work, please refer to following documents in addition: 
 

• XG5000 User’s Manual 
• XGK Instruction List 
• XGR User’s Manual 
 

Following basic specifications apply to the construction of a XGB CANopen module system. 
 

• XGT PLC XG5000 Programming Tool: V3.64 or newer 
• XG-CANopen: V1.0 or newer 
• XBC CPU 

 
Type Version Type Version 

XBM-xxxxS 3.1 or above XEC-xxxxSU 1.0 or above 
XBC-xxxxSU 1.2 or above XEC-xxxxH 1.4 or above 
XBC-xxxxH 2.03 or above XEC-xxxxU 1.0 or above 
XBC-xxxxU 1.0 or above   

 
 
 
 
 
 
 

Note  
1) International standard specification 

CAN: ISO 11898 

CANopen: CiA (CAN in Automation)  DS 301 
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1.2  Features 
The XGB CANopen I/F module has following features.  

1) Satisfies CANopen (CiA’s DS301) specification. 
2) Up to 2 sets can be installed on one unit. 
3) For XBL-CMEA, up to 32 slaves can be connected. 
4) 10K/20K/50K/125K/250K/500K/800K/1Mbps speeds are provided. 
5) For XBL-CMEA, various diagnosis functions and module and network status information is 

provided. 
 
▶ Provide the communication statuses of the master and slave are provided via device diagnosis 

 function. 
▶ The Auto Scan function which provides the information of the modules including from other 

 suppliers connected on the network  
▶ Display latest 5 error histories 

6) For XBL-CSEA, up to 10 latest error histories can be stored 
 

1.2.1  CANopen protocol 

1) Overview 
(1) On the CAN (Controller Area Network) standard, the application protocol CANopen is built in 
(2) Designed for mobility-oriented industrial control systems 
(3) International standard specification 

▶CAN: ISO 11898 
▶CANopen: EN 50325-4 (CiA DS 301) 

 
The CiA 301 specification describes about the overall features of the CANopen including 
CANopen protocol and Object Dictionary. 
 

2) Message classification and communication entities 
(1) Communication service model 

If classified by communicating entities, Producer-Consumer and Server-Client models are used. 
 

(2) Message types 
CANopen sends data in two methods of PDO and SDO. 
a) PDO (Process Data Object) 

The PDO communication is an unconfirmed type communication in Producer/Consumer configuration. 
Therefore, it is used for the process data transmission which requires high speed communication. 
Communication method and data are determined by PDO communication parameter and mapping 
parameter. According to the PDO communication parameter setting, various types of transmission can 
be performed, such as sync, timer, COS (change of state). The mapping parameter connects PDO and 
a certain area of the internal Object Dictionary, so that the received data are stored in the mapped area 
and transmit the data in the mapped area. The transmission and reception data in the mapping area are 
controlled by high-level application. 
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▶ Data transmission types 

Transmission Type Type No. Description 

Synchronous acyclic 0 Synchronous, acyclic, periodic transmission only when the data is changed 

Synchronous cyclic 1-240 
Synchronous, transmission periodically when the SYNC of the transmission type value is 

received 

Reserved 241~251 Reserved 

Synchronous RTR-only 252 Only when RTR is received (RTR-only), synchronous 

Asynchronous RTR-only 253 Only when RTR is received (RTR-only), event driven 

event-driven, 

manufacturer specific 
254 Event-driven, Manufacturer specific 

event-driven,  

profile specific 
255 Event-driven, device profile and application profile are unique 

 
b) SDO (Service Data Object) 

The SDO communication is a confirmed type communication in Client/Server configuration. SDO 
communication is used to access the entries of the Object Dictionary of the CANopen devices, by which 
the device parameters can be set up, stored, and monitored. SDO communication is not conducted 
periodically, but whenever necessary. 

 

     

[Example of SDO transmission using Server-Client configuration] 
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1.3  Production Configuration 

1.3.1  Type Indication 

The product configuration of the XGB CANopen I/F module is described hereinbelow. 
 

Type name Description Remarks 
XBL-CMEA CANopen Master I/F Module  - 
XBL-CSEA CANopen Slave I/F Module - 

 

1.4  Software for using products 
This section describes the major programming tools and other software for using the CANopen module. For further 

details of the programming and communication application, refer to the following descriptions. 

 

1.4.1  Software check-up 
 

Type name Component Product Communication Set-up tool 
XBL-CMEA Communication module for XGB XG-CANopen 

XBL-CSEA Communication module for XGB XG5000 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note  

1) The above software can be downloaded from our Website. If necessary, please visit your nearest distributor to obtain 

respective installation manual in CD-ROM.  

Internet Website: http://www.lsis.biz 
2) XG5000 and XG-CANopen can be programmed via the RS-232C port and USB of the CPU module. Refer to the 

XGT catalog for the connecting cable specification. (USB-301A, K1C-050A) 
 

http://www.lsis.biz/
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1.4.2  XG-CANopen 

 The XG-CANopen is dedicated software to the CANopen Master communication module with the 

functions for the operation of the CANopen master module including the basic parameter set up, 

frame preparation, module and network diagnostics. 

 

The figure below is a snap shot of the initial screen of the XG-CANopen 

 
[Fig. 1.4.1 Initial screen of the XG-CANopen 
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1.4.3  XG5000 

The XG5000 is dedicated software to the communication module with the functions for the operation 

of all the communication modules including the CANopen slave module providing the basic 

parameter set up, frame preparation, module and network diagnostics. 

 

The figure below is a snap shot of the initial screen of the XG5000. 
 

 
[Fig 1.4.2 Initial screen of XG5000 
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1.4.4  Version check 
Before using the XGB CANopen I/F module, please check the version of the module.  

1) Check up via XG5000 

If normally interfaced with the CPU, following information can be obtained. 

(1) Run XG5000. 

(2) Connect to the CPU via online access. 

(3) Select “I/O information” from the online menu. 

Double click or select the respective communication module, and click the “Details” button. 
 

      
  [Fig. 1.4.3] Checking Module Version with XG5000 

 
 

2)  Checking the version with product case label 
The label on the outer package case of each communication module contains module information.  

If the version cannot be checked up via online, because no external access devices such as a 

PC is available, you can check the version by disconnecting the module. 

The information label is attached on the backside of the product, printed with type and version information. 
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Chapter 2 Specification 
2.1  General Specification 

The general specification of XGT series is as follows 
No. Items  Specifications Related standards 

1 
Ambient 

temperature 
0 ~ 55 °C  

2 
Storage 

temperature 
−25 ~ +70 °C  

3 Ambient 
humidity 5 ~ 95%RH (Non-condensing)  

4 Storage humidity 5 ~ 95%RH (Non-condensing)  

5 
Vibration 
resistance 

Occasional vibration -  

Frequency Acceleration Amplitude How many times 

IEC61131-2 

5  ≤  f  <  8.4Hz − 3.5mm 

10 times each 
directions  

(X, Y and Z) 

8.4  ≤  f  ≤  150Hz 9.8m/s2(1G) − 
Continuous vibration 

Frequency Acceleration Amplitude 

5  ≤  f  <  8.4Hz − 1.75mm 

8.4  ≤  f  ≤  150Hz 4.9m/s2(0.5G) − 

6 
Shock 

resistance 

• Peak acceleration: 147 m/s2(15G) 
• Duration: 11ms 
• Half-sine, 3 times each direction per each axis 

IEC61131-2 

7 Noise resistance 

Square wave 
Impulse noise 

AC: ±1,500 V 
DC: ±900V 

LSIS standard 

Electrostatic 
discharge 

4kV (Contact discharge) 
IEC61131-2 

IEC61000-1-2 
Radiated 

electromagnetic 
field noise 

80 ~ 1,000 MHz,  10V/m 
IEC61131-2, 
IEC61000-1-3 

Fast transient/bust 
noise 

Segme
nt 

Power supply 
module 

Digital/analog input/output 
communication interface 

IEC61131-2 
IEC61000-1-4 

Voltage 2kV 1kV 

8 Environment Free from corrosive gasses and excessive dust  

9 Altitude  Up to 2,000 ms  

10 
Pollution 
degree 

Less than equal to 2  

11 Cooling Air-cooling  
 

Note  
 1) IEC (International Electrotechnical Commission): 
   An international nongovernmental organization which promotes internationally cooperated standardization in  

electric/electronic field, publishes international standards and manages applicable estimation system related with. 
 2) Pollution degree:  

An index indicating pollution degree of the operating environment which decides insulation performance of the devices. For instance,  
Pollution degree 2 indicates the state generally that only non-conductive pollution occurs. However, this state contains temporary 
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2.2  Performance Specification 
The following table describes the specification of system configuration in accordance with CANOpen I/F module’s 
media. When you configure systems, refer to the below table.  

Item 
Standard 

XBL-CMEA XBL-CSEA 

Baud rates(kbps) 10, 20, 50, 100, 125, 250, 500, 800, 1000 kbps 

Number of communication Port 1 

The number of maximum Installments 2 
The number of maximum connection 

nodes 
32 - 

The number 
of supported 

PDOs 

TPDO 
Total  32 

64 

RPDO 64 

Maximum data length per a PDO 8Byte 

Transmission type of PDOs 
synchronous acyclic (0), synchronous cyclic(1~240), 

RTR(252~253),time-event trigger(254~255) 
Supported SDO*note 1 Client 127 / Server 1 Server 1 

Transmission type of SDOs Expedited, Normal 

Communication Zone Excess Method CSMA/BA(Carrier Sense Multiple Access/Bitwise Arbitration) 

Topology BUS 

SYNC Service 
Producer, 

cycle: 20~5000ms 
Consumer 

NMT Node Control NMT Master NMT Slave 

NMT Error Control Heartbeat, Life Guarding Heartbeat 

Network Scan Supported - 

Dimension (mm) 90(H) X 27(W) X 60(D) 

Consumption Current (mA) 211 202 

Weight (g) 78 78 

 

Note            
1) SDOs services 

    At the initialization, the object set up can be done in the XG-CANopen “SDO Set-up.” After initialization, SDO 
services can be used during module operation in the two methods as set forth below. 
a) Using XG-CANopen 

- In the SDO set-up window, “Read  All SDOs” or “Read Displayed SDO”: to read the object value of the slave 
- “Write SDO”: to modify the object value of the slave 

    b) XG5000 Command 
      - GETCOM: to read the object value of the slave 

- PUTCOMM: to modify the object value of the slave 
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2.2.1  CANOpen Service  
For the supportability of the XGB CANopen module CANopen service, please refer to the table below..  

 

CANopen Service 
Supportability 

XBL-CMEA XBL-CSEA 

Frame tructure 
CAN 2.0A O O 
CAN 2.0B O O 

PDO O O 
SDO O O 

SYNC O O 
TIME STAMP X X 

EMCY O O 
NMT O O 

ERROR CONTROL O O 
LSS (Later Setting Service) X X 

FLYING MASTER X X 
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2.3  Load Specification 
The specification to transmit PDO without loss is defined with the following formula. Assuming that the 
communication setting variables are as follows; 

1) Baud rate: B (baud rate) 
2) Transmission period: T (ms) 
3) Data size (S): if the mapping data size is 8 byte, 10 byte including overhead 
4) Bits to transmit 1 byte: 10 bits including overhead 

The number of PDOs which can be transmitted is as follows; 
1) Number of transmitted bytes per s (N): B/10 bit 
2) Number of PDOs that can be transmitted per s at the communication speed B (PB): N/10 byte 
3) Number of PDOs that can be transmitted per s at the transmission period T (PT): 1000 (ms)/T (ms) 
4) Number of PDOs that can be transmitted per s at the communication speed B,  

transmission period T (PBT): PB / PT 
The exemplary number of PDOS that can be transmitted according to the values of T and B are as follows. 

Transmission speed 
(B baud rate) 

transmission 
period 
(T ms) 

Transmitted bytes per 
second(N) PB PT PBT 

10,000  20  1,000  100  50  2  

10,000  50  1,000  100  20  5  

10,000  100  1,000  100  10  10  

10,000  200  1,000  100  5  20  

10,000  400  1,000  100  3  40  

20,000  20  2,000  200  50  4  

20,000  50  2,000  200  20  10  

20,000  100  2,000  200  10  20  

20,000  200  2,000  200  5  40  

50,000  20  5,000  500  50  10  

50,000  50  5,000  500  20  25  

50,000  100  5,000  500  10  50  

100,000  20  10,000  1,000  50  20  

100,000  50  10,000  1,000  20  50  

125,000  20  12,500  1,250  50  25  

125,000  40  12,500  1,250  25  50  

250,000  20  25,000  2,500  50  50  

500,000  20  50,000  5,000  50  100  

800,000  20  80,000  8,000  50  160  

1,000,000  20  100,000  10,000  50  200  
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2.4  Component Names 
The names of the module components are as follows 

 
 

 
 

 
 

Item Description Remark 
1 Fixing lever Extension module fixing part (the upper)  

2 LED Display 
Display statuses of module and communication 
In the next page, descript each LED statuses 

 

3 Connector CANopen Connector  
4 DIN rail holder DIN rail fixing part  
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2.4.1  LED Name and Description 

 
1) Common Display 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Error Details 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Item Color Operation Description Remark 

RUN Green 

On Operational state 

Follow CiA303-3 standard 

Blinking 
(200ms On 
200ms Off) 

Preoperational state 
(Only XBL-CMEA) 

Blinking 
(200ms On 
1000ms Off) 

Stopped  

Off 
Not set parameters or connect  
the cable 

I/F Yellow 
Blinking 

Normal operation of a CPU and  
CANOpen module In case of Abnormal state, 

Stop On or Off 
On or Off 

Abnormal operation of a CPU and  
CANOpen module 

TX Green 
Blinking Transmission state 

Transmit data frame 
Off - 

RX Green 
Blinking Receiving state 

Receive data frame 
Off - 

ERR Red 
On or  Blinking Error occurrence 

Follow CiA303-3 standard 
Off Normal operation 

Item Operation Description 
XBL-CMEA XBL-CSEA 

ERR 

Off Normal operation 
Blinking 1 

note1) 
Not equal a number of slaves having 
setting parameter and connected slaves 

- 

Blinking 2 

note1) 
Error Passive state (TEC>=128 or REC>=128 note2)) 
(Not equal baud rates or error cable connection) 

Blinking 3 

note1) 
Error control event(occurrence heartbeat error) 

On  not connected 
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Note            
1)Blinking details 

a)Blinking 1 

 

b)Blinking 2 

 

c)Blinking 3 

 

2) REC: Receive Error Counter, TEC: Transmit Error Counter 
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2.5  Cable Specification 

The cables, connectors and terminal resistors used in the CANopen network must be in compliance with 

the ISO 11898 specification. 

 

2.5.1  Bus cable and Terminal resistor 

According to the ISO 11898 specification, the CAN bus network must be terminated with the 2 end 

resistors as shown in the figure below. 

 
In most cases, the wires with 0.25 ~ 0.34㎟ of cross section area are recommended for the drop 

cables. The actual resistance of the connector must be included in the voltage drop calculation, in 

addition to the cable resistance. The transmission resistance of the connector shall be between 2.5 

~ 10 ㏁. 

The table below presents the lengths of the bus cables per baud rate. 

 

 

 

 

 

 

 

 
Note            
1) Recommended cable AC parameter: 120Ω impedance, 5㎱/m  

 

Baud rate[bit/sec] Length of BUS cable[m] 
1M 25 

800k 50 
500k 100 
250k 250 
125k 500 
50k 1000 
20k 2500 
10 5000 
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Assuming that the following values are given, the maximum wire length varies by the bus cable and 

the number of connected bus nodes. 

1) Min. dominant value Vdiff.out.min = 1.5 V 

2) Min. differential input resistance Rdiff.min = 20 kW 

3) Required differential input voltage Vth.max = 1.0 V 

4) Min. terminating resistance RT.min = 118 W 

 

Cross-section 
[㎟] 

Maximum length[m]*note1) Maximum length[m]*note2) 
n = 32 n = 64 n = 100 n = 32 n = 64 n = 100 

0.25 200 170 150 230 200 170 
0.5 360 310 270 420 360 320 
0.75 550 470 410 640 550 480 

 

 
 
 
 
 
 
 
 
 
 

Note            
1)Safety margin for 0.2 
2)Safety margin for 0.1 

 

2.5.2  CAN Ground and Galvanic Isolation 

In general, CAN ground has to be connected. However, in a perfectly galvanic-isolated CANopen network, the 

CAN ground may not be connected.  
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2.5.3  Communication Connector 

XGB CANopen uses open-type connectors. See CiA 303-1 for other connectors recommended by 

CiA. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No Signal Description 
1 GND Ground 
2 CAN_L CAN_L bus line (dominant low) 
3 SHIELD Optional CAN Shield 
4 CAN_H CAN_H bus line (dominant high) 
5 N.C Not Connected 

 
 
 
 
 
 
 
 

Note            
CiA 303-1 Cabling and Connector Pin Assignment provides the recommendations for various types of cables  
and connectors. 
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Chapter 3 Installation and Trial-Run 
 

3.1  Installation Environment 
This product is very reliable regardless of installation environments, but to guaranty the reliability and stability of the 
system, pay attention to the following items.        
    

1) Environment Conditions  
(1) Install in the control board where waterproof and dustproof are possible. 
(2) The places where constant impacts or vibrations are imposed. 
(3) The places where direct rays are not directly exposed . 
(4) The places where dew is not formed by the rapid change in temperature. 
(5) The places where surrounding temperature is maintained to be at 0-55℃. 

 
2) Installation Constructions  

(1) Make sure wiring leavings are not inserted inside the PLC when you process screw holes or do wiring 
jobs. 

(2) Install the places where it is easy to control.  
(3) Do not install into the same panel as high press machine. 
(4) Make sure the distance to the duct and the surrounding module is maintained to be more than 50㎜. 
(5) Put to earth where surrounding noise environment is good. 

 

Over 100mm 

Over 50mm 

Over 50mm 
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3.2  Cautions when Handling 
Observe the following directions when you configure the system using CANopen I/F module. 

 
1) Do not drop or impose strong impact. 
2) Do not separate PCB from the case. It may cause malfunctions. 
3) Make sure foreign objects are not put into the upper area of the module while you do wiring jobs.  
4) If foreign objects are entered, remove them. 
5) Do not remove the module when light is On. 
6) Use standard cables and install within maximum distance.  
7) Make sure communication lines are not affected by surges and inductive noises that may occur from 

alternating current or current parts. 
8) In case the machinery or the substances that may generate high temperature are nearby you or when wires 

directly come into contact oil and other things for a long time when you do wiring jobs, it may cause a short 
cut, damage, or   malfunctions. 

9) When you do wirings during pipe arrangement, it is necessary to put to earth to pipes. 
. 
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3.3  The Order for Setting up Products till Running 
The following describes the order of installing or setting up products. Install the system and setting up the parameter 
so that they can operate in order. 

 
 

3.3.1  Setting Sequence of Master module(XBL-CMEA) 
1) Check functions and specifications 
2) Mount the module 
3) Check I/F LED status of the communication module (flashing) after turning it on 
4) Connect with XG-5000 
5) Execute module synchronization. 
6) Double click on CANopen Network from XG5000 parameter window and execute XG-CANopen. 
7) Set basic parameters of the master module (XBL-CMEA) 
8) Add slaves by directly inputting them or through auto scan. 
9) Set parameters of each slave 
10) Execute ‘Write Parameter’  
11) Implement link enable on the master module that sets parameters 
12) Implement CANopen master’s action. 
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3.3.2  Setting Sequence of Slave module(XBL-CSEA) 
 

1) Check functions and specifications 
2) Mount the module 
3) Check I/F LED status of the communication module (flashing) after turning it on 
4) Connect with XG5000 and execute ‘Read I/O Information’. 
5) Select CANopen slave from the basic setting window. 
6) Set basic parameters (station number, communication speed, readable area, saving area) 
7) Download parameters. 
8) Implement CANopen slave’s action. 
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3.4  Installation of Product 

3.4.1  Installing CANopen I/F Module 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CANopen’s maximum segment length may vary depending on speed.  
Use shielded cables. 
 

No Signal Description 
1 GND Ground 
2 CAN_L CAN_L bus line (dominant low) 
3 SHIELD Optional CAN Shield 
4 CAN_H CAN_H bus line (dominant high) 
5 N.C Not Connected 

 
 

 
 
 

Note   

Recommended cable AC parameter: 120Ω impedance, 5㎱/m  
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3.4.2   Transfer distance by communication speed 

 
The transfer distance by communication speed specified in the CANopen specification is as follows.  

 
Bit rate Bus Length 
1 Mbit/s 25 m 

800 kbit/s 50 m 
500 kbit/s 100 m 
250 kbit/s 250 m 
125 kbit/s 500 m 
50 kbit/s 1,000 m 
20 kbit/s 2,500 m 
10 kbit/s 5,000 m 

 
 

 

3.5  Trial-Run 

3.5.1  Caution in Configure the System  
1) All station numbers in CANopen device including the master module should be different. 
2) Use a designated cable for communication. If you use other cables, it may cause serious communication 

problems.  
3) Inspect whether the cable is disconnected or short-circuited before installing the communication cable.    
4) Firmly tighten the communication cable connector to make sure the cable is completely connected.  
5) If the connection is loose, it will cause serious communication problems.  
6) If the length of the communication cable is longer, keep the cable away from power line or inductive noise.  
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Chapter 4 System Configuration 
 

4.1  System Configuration 
In XGB, CANopen I/F module and all other modules can be mounted up to two on one basic unit, regardless of the 

module type. Since the open protocol CANopen is used, bus topology system configuration is available using other 

supplier PLC’s CANopen module, Inverter, and HMI. 

 

(1) Network Configuration 

 Up to 127 CANopen slaves can be connected. The maximum number may be limited by the number of the slaves  

allowed by the master, see the technical document of the master. Up to 32 XBL-CMEA can be connected. 

 
 
 (2) 1:1 Connection 

 
(3) 1:N Connection 

 
 

Note  

1) Make sure to connect the terminating resistor (120 Ω, 1/2 W). 

2) GND may be connected to the system as necessary. 
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Chapter 5 Using XG-CANopen 
5.1   Screen Configuration 

 

The XG-CANopen screen has 6 configurations as shown on the figure below. 

 

 
 

 
① Menu: the main menu of the program.   
② Toolbar: menu items can be selected and executed conveniently. 
③ Project window: shows the components of the currently active project. 
④ Library window: shows the slave module list where EDS file is registered. 
⑤ Edit window: network configuration, master module and slave module can be configured. 
⑥ Message window: show the messages generated during XG-CANopen operation.  
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5.1.1  Menu Structure 
There are configured as following  

 
Project 

Instruction Description 

New Project Create a new project 

Open Project Open an existing project. 

Open form PLC Upload the project and program in the PLC. 

Save Project Save a project. 

Save As Save the project under a different name. 

Close Project Close a project. 

Export Save the contents of the XG-CANopen project in a file. 

Import Upload the exported file from the XG-CANopen.  

Export as package Save the contents of the XG-CANopen project and used EDS files. 

Import from package Upload the exported file from the XG-CANopen and used EDS files. 

Compare projects Compare two project and show the result. 

Print Print the content of the active window. 

Print Preview Show the screen to be printed. 

Project Print Select and print project item. 

Print Setup Set up printer options 

End Terminate XG-CANopen 

 
Edit 

Instruction Description 

Cut Delete a block and copy the content to the clip board. 

Copy Copy the content of the block to the clip board. 

Paste Copy the content of the clip board to the edit window. 

Delete Delete a block or selected item. 

Open Item Open the item selected in the project window. 
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View 

Instruction Description 
Build Perform parameter inspection and allocate variables. 

Status Bar Show or hide the status bar at the bottom screen of XG-CANopen. 
Project Window Show or hide project window. 
Library Window Show or hide library window. 

Message Window Show or hide message window. 
View Network For each master module, activate a window where slave can be added or deleted. 

Default Window Position Shift the project window, library window and message window to the initial positions. 

Zoom In Enlarge the network setting screen. 
Zoom Out Reduce the network setting screen size. 

View In Detail In the network setting window, show the master and slave information in detail (portrait 
configuration). 

View Brief In the network setting window, show the master and slave information in simple form 
(landscape configuration). 

View As List In the network setting window, show the master and slave information in list form. 
View As Table In the network setting window, show the master and slave information in tabular form. 

Properties View and modify the registered information of the selected master or slave. 
 

Online 

Instruction Description 

Connect Connect or disconnect from PLC. 
Connection Setting Set up connection method. 

Module Synchronization  
Write Write the project in the PLC. 
Read Read the project from the PLC. 

Start Monitor Start/stop monitoring PDO data or Device status 
Write SDO Write data in the designated SDO. 

Slave Error History  

Instruction Description 

Slave Status by Service  
Autoscan Show the information of the slave connected with the master. 

Add to Autoscan in project  
View Autoscan with project  

Reset PLC Reset the PLC. 

Download OS 
(Reserved) 

Used for upgrading the version of the XBL-CMEA I/F module. If you need to 

upgrade for firmware, please contact near service center. 

Enable Link  
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Tool 

Instruction Description 

Library Manager Register or delete EDS file on/from the library. 

Update Library Update the library with the EDS files saved in the library folder. 

Customize User can define the tools and instructions. 

Shortcut Setting User sets up shortcut keys. 

 
Window  

Instruction Description 

Cascade XG-CANopen windows are arranged in cascade form. 

Title Horizontally XG-CANopen windows are arranged horizontally. 

Title Vertically XG-CANopen windows are arranged vertically. 

Arrange Icons XG-CANopen icons are arranged. 

Close All Close all the XG-CANopen windows. 

 
Help 

Instruction Description 

About XG-CANopen Show XG-CANopen information. 
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5.1.2  Toolbar 

XG-CANopen provides frequently used menus in icon form. 

Click the desired tool to execute the function. The user can create a customized toolbar with frequently used 

tools. 

 
1)  Creating a new toolbar  

The user can create a customized toolbar with frequently used tools. 

No Process Procedure 

1 

Customize 

 

1. Toolbar: in the list, check the name of the toolbar to view or hide it. 

2. New Tools: create a new toolbar. 

3. Reset: reset the toolbar. 

4. View toolbar tip 

5  Cool shape 
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No Process Procedure 

2 

Creating a new 
toolbar 

 

1. Select the menu [Tool] - [Customize]. 

2. Click the New Tools button. 

3. Enter the toolbar name in the New toolbar dialogue box. 

4. Click the OK button. A toolbar without a tool is created. 

 

3 

Filling Toolbar 

 

 

 

1. Click the Command tap. 

2. Drag-and-drop frequently used tools into the new toolbar with the mouse. 

3. Click OK button. 
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5.2  Setting-up Shortcut Key 
All the instructions can be assigned with a shortcut key. When set up, the old key, if any, is deleted. The 

set up procedures are as follows 

 

No Process Procedure 

1 

Shortcut Key 
Dialogue 

Description 

 

1. Select a macro: select the menu for which a shortcut key is to be assigned from the list. 

2. Create shortcut: create a shortcut key for the selected menu item. 

3. Remove: Remove the set up shortcut key. 

4. Rest all: delete all the user defined shortcut keys and reset the shortcut key settings to the default setting. 

2 

Setting-up 
Shortcut Key 

 

1. Select menu: select a macro for which a shortcut key is to be assigned from the list. 

2. Click the Create Shortcut Key button. 

3. Press the shortcut key to be set up.  

For example, to set up Ctrl + C as a shortcut key, keep pressing the Ctrl key and press C key in the keyboard.  

The edit window will show the shortcut key. If the key set has already been in use, the shortcut key will show  

the menu item.   

4. Click the OK button. 
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Chapter 6 XG-CANopen detail Menu 
6.1  Project 

The project configuration items are as follows; 

 
 

 

1. Project: represents the project   

2. CANopen Network: represents the CANopen system respective to one CPU module                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                  

3. Master: represents the master module  

4. Slave: represents the slaves connected to the master.  
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6.1.1  Project File Management 

1)  Creating a New Project 

Create a new project. At the same time, a folder of the same name that of the project is  

created containing the project file. 

 

            

No Process Procedure 

1 

Creating a New 
Project 

 

1. Select menu [Project]-[New Project]. 

2. Project name: enter desired project name. The name will be the name of the project.  

3. Directory: a folder with the entered project name is created and the project file is created in the folder. 

4. Searching box: looking up the existing folders, allocate the project file location. 

5. Network type: select the network type. 

6. CPU type: select the CPU type. 

7. Project comment: enter project description text. 
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6.1.2   Opening Project 

 

6.1.3  Open from PLC 
Read the memory stored in the PLC and create a new project. If a project is open in the XG-CANopen, close 
the project and create a new project. 

No Process Procedure 

1 

Open Project 

 

1. Select menu [Project]-[Open Project]. 

2. Select the file and click Open. 

No Process Procedure 

1 

Open from PLC 

 
1. Select menu [Project]-[Open From PLC]. 

2. Select the connect option and click Connect. 
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6.1.4  Other Functions 

Function Meaning Execution Method 

Save Project Save the modified project. Select menu [Project]-[Save Project]. 

Save As  Save the project in a different file. 

1. Save the project in a different file. 

2. Enter the project name and click 

Confirm button. 

Export as Package 

Save the project contents in a file archive.  

Exporting file archive also saves the EDS file 

information used in the project. 

1. Select menu [Project]-[Export  as 

Package]. 

2. Enter the name for saving and click 

[Save] button. 

Import from Package 

Import the project archive file.  

Importing file archive also loads the EDS file 

information used in the project. 

1. Select menu [Project]-[Import  from 

Package] 

2. Enter the name of the archive file and 

click [Open] button. 
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6.2  Interconnection with XG5000 
XG-CANopen supports interconnection with XG5000. 

If XG-CANopen is opened via XG5000, the project file and Write PCL functions are interlocked with 

the XG5000 project.  

To use the devices allocated by the XG-CANopen in XG5000, run XG-CANopen in the XG5000. 

 

6.2.1   Opening XG-CANopen in XG5000 

To run XG-CANopen in XG5000, the CANOpen master module (XBL-CMEA) must be registered in 

the I/O parameter. Master module can be added in I/O parameter by two methods. 

1)  Master module registration by I/O synchronization 

No Process Procedure 

1 

I/O 
Synchronization 

  

1. Select menu [Online]-[Change Mode]-[Stop] to switch to CPU stop mode. 

2. Select menu [Online]-[Diagnosis]-[I/O Information], and select [I/O Sync] in the I/O information window. 

3. When the module has been synchronized, click OK button. 

2 

Executing  

XG-CANopen 

 

1. CANopen Network item is created in the project window. 

2. Double click CANOpen Network to confirm execution of XG-CANopen. 
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2)  Master module registration by I/O parameter setting 

 

No Process Procedure 

1 

I/O Parameter 
Setting 

 

 

1. In the XG5000 project window, select menu [Parameter]-[I/O Parameter]. 

2. In the XG5000 I/O parameter window, select CANopen Master. 

2 

Executing  
XG-CANopen 

 

1. CANOpen Network item is created in the project window. 
2. Double click CANOpen Network to confirm execution of XG-CANopen. 
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6.2.2  Saving a Project 
When the XG-CANopen is executed in connection with XG5000, saving the project in XG5000 will save the 
setting of the XG-CANopen too. 

6.2.3  Variable Allocation 
PLC devices are allocated to the PDO set up in the XG-CANopen. When the XG-CANopen is opened via 
XG5000, the variables allocated in the XG-CANopen can be used in the XG5000. 
 

6.2.4   Allocating Variables in XG-CANopen 
PLC devices are allocated to the set up PDO..  

 
[Procedure]   
Select menu [View]-[Build] 

 

6.2.5   Importing the variable allocated in the XG5000 

The variables allocated in the XG-CANopen can be imported to XG5000 to use the variables in 

the PLC program. 

 
[Procedure]   

1. Select XG5000 menu [Edit]-[Automatic allocation of network variables]. 

2. Network variables are added to the global variables or variables/description window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note  

Variable allocation is carried out in the following cases; 

1) Menu [Build] of the XG-CANopen is executed 

2) Project is saved in the XG-CANopen 

3) XG5000 menu [Automatic allocation of network variables] is selected. 
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6.2.6  Compare Projects 
Two projects can be compared item by item. The result of the comparison is displayed in the message 
window. 

No Process Procedure 

1 

Execute 
Compare 
Projects 

 

Select menu [Project]-[Compare Projects]. 

2 

Opening the 
file to be 

compared 

 

1. Click the [Open Project] button in the dialog box. 

2. Select the file to compare with and click [Open] button. 

3 

Result of 
Comparison 

 

Click the [Compare] button. The result of the comparison is displayed in the message window. 
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6.2.7  Other Functions 
 

Function Meaning Execution Method 

Export 
Save the contents of the XG-CANopen project 

in another file. 

Select menu [Project]-[Export]. 

 Enter the name for saving and click 

[Save] button. 

Import 
Load the contents of the XG-CANopen project 

saved in another file. 

Select menu [Project]-[Import]. 

Enter the file name and click [Open] 

button. 

Export as Package 

Save the project contents in a file archive.  

Exporting file archive also saves the EDS file 

information used in the project. 

1. Select menu [Project]-[Export  as 

Package]. 

2. Enter the name for saving and click 

[Save] button. 

Import from Package 

Import the project archive file.  

Importing file archive also loads the EDS file 

information used in the project. 

1. Select menu  

[Project]-[Import  from Package] 

2. Enter the name of the archive file and 

click [Open] button. 
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6.3  Edit Network Window (Add/Delete Master and Slave) 
Master and slave nodes can be added or deleted to configuration the network. Detail set up can be 

conducted by calling up the registration information window of the nodes. 

. 
 

6.3.1  Conditions 

Following functional restrictions are imposed when configuring a network. 

 

Item Description Limit 

Max. No. of masters Max. No. of the masters allowed to be mounted on a PLC 2 sets 

Max. No. of slaves Max. No. of the slaves allowed to be mounted on a PLC 32 sets 

Slave station No. Slave ID 1 ~ 127 

Max. No. of copy nodes Max No. of the nodes which can be copied at once 1 

Max. No. of paste nodes Max No. of the nodes which can be pasted at once 1 

 

6.3.2  Edit Node 
1) Entering master module name 

 

No Process Procedure 

1 

Master 
additional 
selection 

 

1. Enter master node in the CANopen Network 

2. In the project window, select [CANopen Network] and right click the mouse to select Add Master .  
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No Process Procedure 

2 

Entering Detail 
Contents 

 
1. Select [Add Master] to pop-up add master module dialogue. 

2. Enter following information in the master module window, and click Confirm. The meanings of the items are  

as follows; 

 1) Name: enter name of the master node 

2) Module : select master module type 

3) Base: select the base on which the master module is to be mounted  

4) Slot: select the slot in which the master module is to be inserted 

5) Comment: enter other information of the master module.  

3 

Check Edit 
Window 
Creation 

 

 

After finishing the entry and select [View]-[View Network], the network window of the master module is created in the edit 
window. 
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2)  Adding Slaver modules 
Slaves can be added by two methods. The first method is to add a slave directly to the master 

module, and the second is using Auto Scan. To use the Auto Scan function, the slave must be 

connected to the network with the same baud rate and different station No.. 

 
(1) Adding at Master module 

 

No Process Procedure 

1 

Add Slave 

  or  

1. Select the master module and right click the mouse to select [Add Slave]. 

2.Or, in the edit window, click the master module and select [Add Slave]. 

2 

Slave 
Properties 

   

1. Enter following items in the slave window; 

- Station No.: enter the slave node ID 

- Name: enter name of the slave node  

- Device: enter the EDS product name of the slave node.  

- EDS: enter the EDS file path of the slave node.  

2. Click EDS call-up button and add the desired EDS. 

3. Click OK button. 
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No Process Procedure 

3 

Select Add to 
Master 

 

In the network window, the slave is added beneath the master module. 
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(2) Adding Slaver in the AutoScan 

No Process Procedure 

1 

Adding a Slave 

   

1. Select [Online] → [Auto Scan] 

2. Select [Online] → [Add AutoScan in Project ] 

2 

Check Slave 
Registration 

 

Check that the slaves are added in the project window 
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6.3.3  Deleting Master Module 

 
Note  

If delete the master module, parameter of slaves set in master will be deleted. 
 

No Process Procedure 

1 

Deleting Master 

  

1. In the project window, select the master module to be delete 

2. Click select [Delete] or Select menu [Edit]-[Delete]. 



 
 
 
 
Chapter 6 XG-CANopen detail menu 

 

 6-16 

6.3.4  Deleting Slave 

 

No Process Procedure 

1 

Deleting 
Slave 

 

 
 

1. In the project window, select the slave module to be deleted. 

2. Select menu [Edit]-[Delete]. From the project window, the selected slave module is deleted.  

Or, Slave module can be deleted in the network window.  
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6.3.5  Copy/Paste/Cut 

 

No Process Procedure 

1 

Copy 

   

1. Select the module to be copied. Select menu [Edit]-[Copy].  

Or, select the slave and right click the mouse to select [Copy]. 

2 

Paste 
 

 

 
 

1. Select a slave and select menu [Edit]-[Paste].  

2. Add Slave dialogue will appear.  

3. Suffix “_COPY” is attached to the end of the name of the copied slave. 

4. Enter basic entries for the slave. 
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No Process Procedure 

3 

Cut 

 

1. Select the slave to be cut off. 

2. Select menu [Edit]-[cut]. Or, select the slave and select Cut from the context menu. 

3. The cut slave can be pasted with the method described in the above Clause 2. 
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6.3.6  Drag and Drop 
Slave modules can be added by drag-and-drop  

 
 

No Process Procedure 

1 

Drag 

 

1. Select EDS file from the library window. 

2. Drag the file and drop it in the network window. 

2 

Drop 

 

1. Add Slave dialog will appear. As the default, product name and EDS file path are displayed. 

2. Enter station No. and name in the slave dialog, and OK Confirm. 
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6.4  Library 

6.4.1  Overview 
The library means the set of the EDS (Electronic Data Sheet) currently registered in the XG-CANopen. When 
the user registers the EDS via library administrator, the XG-CANopen automatically updates the library, and 
the information is maintained until the EDS registration is revoked. 
 

6.4.2  Library Window 

1) Library Window Configuration 
 To activate the library window, select menu [View] – [Library Window]. The library window consists of the 
EDS library tab which shows all the registered EDSs and the Favorite tab which shows desired EDS only. 
The EDS registered by the user is classified into manufacturer information and profile information and 
registered in tree structure. From the EDSs, desired EDS can be find out easily using the manufacturer 
and profile information. The library window tree consists of the product name and file name of the EDS. 

 

 
 

2) Find EDS 
From the EDSs, desired EDS can be find out easily using the [Find] control at top of the library window. 

Any character can be used in the search key word. Use the  buttons for search after entering 

the search key word. The directions of the buttons are the directions of the search. 

The ENTER key has the same function as that of the  button. 
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3) Registering favorite EDSs 
If many EDSs are registered, it is recommended to control the ‘My Favorite’ EDSs separately for 
convenience. To register an EDS in the ‘My Favorites,’ right click the mouse and select [Register in 
Favorites]. The registered EDSs can be confirmed with the My Favorites tab of the library window. 

 
 

4) View EDS Content 
To view the content of a registered EDS, right click the mouse on the EDS and select [View EDS] menu. A 
new window showing the whole content of the EDS will appear, showing the following information; 

 

▶ File path: shows the absolute path of the selected EDS.. 

▶ Search content: enter key word(s) to search EDS content. The keyword is case sensitive and searches 
unit word basis*Note1). (Use check box). 

Note  
1) Unit word based search: the search keyword is considered to be a complete word and searches exact 

 matches only 

 E.g.) If the search object is ObjectType=0x7, 

If ObjectType is entered, the search will succeed, and fail if ObJect is entered. 

    ObjectType=0x7 will succed, and ObjectType=0 will fail 
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6.4.3  Library Manager 

The library administrator is used to register a new EDS or revoke one, or to modify the image file 

registered together with the EDS. 

1) Register EDS file 

No Process Procedure 

1 

Register EDS 
file (1) 

 

Select [Tool]-[Library Manager], select Register EDS file and click [Next] button. 

2 

Register EDS 
file (2) 

 
11. Select the EDS file and image file, and click Next button.  The selected image can be viewed in the Image Preview in 

square form.  Can proceed to the next step without selecting an image. 

2. Click [OK] button to complete the EDS registration. 
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2) Unregister EDS file 

 

No Process Procedure 

1 

Unregister 
EDS file(1) 

 

Select [Tool]-[Library Manager], select revoke EDS file registration and click [Next] button. 

2 

Unregister 
EDS file (2) 

 

1. Select the EDS file to be deleted and click [Next] button. The image, if any, registered with the EDS will 

appear at the same time. 

2. Click [Finish] button to complete the EDS revocation. 

3. The revoked EDS file is stored in the Deleted EDS folder of the XG5000 folder. 
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3) Change Image 

 

No Process Procedure 

1 

Change Image 
(1) 

 

Select [Tool]-[Library Manager], select Change Image and click [Next] button. 

2 

Change Image 
(2) 

 

11. Select the EDS file and image file to be changes, and click [Next] button. The selected image can be viewed in the 

Image Preview in square form. 

2. Click [Finish] button to complete the change into the selected image. 
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6.5  Online 
The functions available only when connected with PLC are described below. 

 

6.5.1  Connection Setting 
The connection method of XG-CANopen can be classified into RS-232C, USB, modem, and Ethernet, 
according to the connection media. Local and remote connection are supported. For further details, see 
Chapter 10, Online of the XG5000 User’s Manual.   

 

6.5.2  Write 
This function writes the CANopen parameter set up in the XG-CANopen to the CANopen master module. 
The CANopen parameter can be written in the XG-CANopen or via XG5000. 

 
1) Write in XG-CANopen 

Transmit the set-up master and slave information to the CANopen master module. 

 

No Process Procedure 

1 

Write in XG-
CANopen 

 

1. Select menu [Online]-[Connect] to connect the PLC via online. 

2. Select menu [Online]-[Write].  
3. Select the master to which write parameter 

2 

Writing 
Complete 

 

 When writing is completed, finish window is created. 
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2) Write in XG5000 
When the XG-CANopen is called in the XG5000, the XG-CANopen is synchronized with the XG5000. 
Therefore, if writing is conducted in the XG5000, and if the CANopen module has been set up, CANopen 
parameters are also written. 

No Process Procedure 

1 

Adding Module 
 

 
<Adding CANOpen Master using I/O parameter> 

 
<Adding CANOpen Master by I/O synchronization> 

1. Add master module to create the CANOpen Network menu in the XG5000 project window. 

 1) In the XG5000 project window, double click I/O parameter to add CANopen module, or 

 2) Select [Online]-[I/O Information] menu of XG5000 and select [I/O sync.]. To execute I/O synchronization  

the CPU must be in stop state. 

2) Confirm that CANOpen Network is created in the XG5000 project window when the module has been added. 

2 

Writing 
Parameter 

 

1. Double click the CANopen Network added in the project window. 

2. The XG-CANopen will start up and edit parameter for CANOpen 

3. Save project in the XG5000. 

4. Conduct XG5000 menu [Online]-[Write]. 
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Note  

The content edited in the CANopen in connection with the XGB CPU module is saved in the CANopen 

master module. 

When replacing the CANopen master module, backup the parameter setting using the XG5000 or XG-CANopen. 
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6.5.3  Read 

This function reads CANopen parameters from the CANopen master module. Reading can be conducted in 

the XG-CANopen or XG5000. 

 
1) Read  in  XG-CANopen 

Read the parameters stored in the CANopen master module. 
  

 
 

No Process Procedure 

1 

Read form PLC 

 

1. Select menu [Project]-[Open From PLC]. 

2. Enter connection setting and click the Confirm button. 

3. When reading has been completed, finish window appears. 

2 

Read 

 

1. With the project open, select menu [Online]-[Read] to connect the PLC via online. 

2. Select menu [Online]-[Read]. 

3. If there are two masters in the open project, select Master. 
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2) Read in XG5000 
If reading is carried out in the XG5000, and if CANopen master module is installed, CANopen parameters 
are read, too 

 
 
 

Note  
Only when the CANopen module is set up in the base/slot information of the I/O parameter, CANopen parameter 
information is read from the CANopen master module. 

 
 
 

No Process Procedure 

1 

Open from 
PLC 

 

1. Select menu [Project]-[Open From PLC]. 

2. Enter connection setting and click the Confirm button. 

3. When reading has been completed, finish window appears. 

2 

Read 

 

1. With the project open, select menu [Online]-[Connect] to connect the PLC via online. 

2. Select menu [Online]-[Read]. 
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6.5.4  Monitor  
XG-CANopen monitor displays PDO variable (device) values and diagnosis variable values. 
PDO variable values can be viewed in the PDO variable table in the master set up window and the values of 
the diagnosis variables can be viewed in the system configuration diagram window. 

 
[Order] 
1. Select menu [Online]-[Connect] to connect the PLC via online. 

2. Select menu [Online]-[Start Monitor] to start monitor. 

3. If the PDO variable tab and diagnosis variable tab are active, monitor mode is activated. 
4. Select menu [Online]-[End Monitor] to stop the monitor, 

 
 

1) Monitor function in the View Network 
[Order] 
1. In the monitor mode, select [View]-[ View Network]. 

 

 
 

Note  
For the monitor function, accurate monitoring of the current status is possible only when the error control setting of the 
slave is selected. 
In the default network view, the meanings of the states are as follows; 
1) No monitor value in the monitor mode: monitor value has yet not been read after starting up the monitor.  

Momentarily appeared and then disappeared soon. 
2) If the master status is error; 

a) When no monitor value is available 
b) When the channel status is error: if any one or more of the channel status is 1 
c) When the common status is error: if any one or more of the common status is 1 
d) When the event status is error: if any one or more of the event status is 1 
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3) About the slave node 
a) No monitor value in the monitor mode: monitor value has yet not been read after starting up the  

monitor. Momentarily appeared and then disappeared soon. 
- Slave status: not allocated to the master. 

b) If the slave status is error:  
(1) No monitor value is available 
(2) Configuration error 
(3) EMCY error 
(4) If not in operational mode 

4) Color indication 
  a) if in monior mode 

(1) Green: normal 
(2) Red: Error. For master node, refer to master status error,  

For slave node, refer to slave stauts error 
 b) If not in monitor mode (edit mode): white 
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6.5.5  Write SDO 
The SDO value of slave module can be modified. The changed value after SDO writing can be checked using the 
SDO setting tab in the slave edit window by viewing all or viewing current screen only..  

 

No Process Procedure 

1 

Write 
SDO  

 

 

1. Select menu [Online]-[Access] to connect the PLC 

2. Select menu [Online]-[Writing SDO], or click SDO setting in slave side, and right click the mouse at the object with  

which Write SDO will be executed, and carry out write SDO. 

3. In the Write SDO dialog, edit the object index and sub-index values, and select the Write button. 

Here, Write SDO is allowed only when the access attribute of the object list is RW. 
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6.5.6  Read SDO  
The current value of the SDO in the slave module can be read. Select [Read All or Read Current Screen  
Only from the SDO setting tab in the slave edit window.  

No Process Procedure 

1 

Select SDO 

 

1. Double click the slave item in the project tree, open the specification edit window. 

2. In the slave edit window, select SDO Setting. 

2 

Read SDO 
 

 

1. Select menu [Online]-[Connect] to connect the PLC 

2. Select [Read All SDOs] or [Read Displayed SDOs] button. 

3. The SDO value read from the object list in the SDO setting tab is displayed in the monitoring value. 
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6.5.7  Slave Error History 

Shows the latest 5 errors of the individual slave which is conducting CANopen communication . 

 

순서 설정과정 설정방법 

1 

Slave Error 
History 

 

1. Select menu [Online]-[Connect] to connect the PLC 

2. From the project tree, select the slave item for which error history is to be searched. 

3. Select menu [Online]-[Slave Error History]. 

2 

Detail Slave  
Error History 

 

1. Station No.: shows the station No. of the slave 

2. Error code: shows the error code 

3. Content: shows the content of the error  

4. Manufacturer error code: shows the error code inscribed by the slave manufacturer 

5. Clear History: Clear the slave error histories 

6. Close: close the dialog. 
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Note  

CiA(CAN in Automation) Standard defines error code as follows. 
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6.5.8  Slave Status by Service  
Shows the PDO/SDO service statuses . 

 

 

No Process Procedure 

1 

Slave Status by 
Service (PDO 

service) 

 

1. Select menu [Online]-[Connect] to connect the PLC 

2. From the project tree, select the slave item for which error history is to be searched. 

3. Select menu [Online]-[Slave Service by Status]. 

4. The details of the system history are as follows; 

(1) No.: order of parameter during downloading 

(2) Station No.: shows the station No. of the slave 

(3)  Kind: shows the type (TPDO, RPDO) of the PDO 

(4)  Transmission type: shows the transmission type of the PDO 

(5)  COB-ID: shows the COB-ID of the PDO. 

(6)  Address: shows the starting address of the device mapped on the PDO 

(7)  Length: shows the entire size of the object mapped on the PDO 

(8)  NMT status: shows the status of NMT  

-The NMT status can be INIT, PREOPERATIONAL, OPERATIONAL, or STOPPED 

(9)  Block status: shows the status of PDO block 

-The block status can be INIT, NORMAL, or ABNORMAL  

(10)  Service count: shows No. of services per one second 

(11)  Flag clear: initializes the values of the No, of services per s, No. of services, and No. of errors 

(12)  Multiple Reading: reads PDO service status continuously 
(13)  Refresh: reads PDO service status again 
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No Process Procedure 

2 

Slave Status by 
Service 

(SDO Service) 

 

1. Select menu [Online]-[Connect] to connect the PLC 

2. From the project tree, select the slave item for which error history is to be searched. 

3. Select menu [Online]-[Slave Service by Status]. 

4. In the status by service dialog, select [SDO Service] tab. 

5. The details of the system history are as follows; 

(1) No.: order of parameter during downloading 

(2) Station No.: shows the station No. of the slave 

(3) NMT status: shows the status of NMT  

-The NMT status can be INIT, PREOPERATIONAL, OPERATIONAL, or STOPPED 

(4) Service count per second: shows No. of services per one second 

(5) Service count: shows No. of all the services 

(6) Error count: shows No. of all the errors 

(7) Flag clear: initializes the values of the No, of services per s, No. of services, and No. of errors 

(8) Multiple reading: reads SDO service status continuously. 

(9) Refresh: reads PDO service status again. 
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6.5.9  Autoscan 
From a real CANopen network whose device configuration is unknown, collect slave information 
via master module and investigate the network configuration to create a configurable topology 
screen. 
Result of Autoscan is displayed in the network configuration screen. The list of the slaves  to the master 
which has conducted Auto Scan is created. 
The display window varies by the View mode of the network window. 
If [Autoscan] menu is clicked again during Auto Scanning, the Autoscan information is read to 
update the screen. 

 

[Order] 
1. Select menu [Online]-[Connect]. 
2. Select the master which will conduct Auto Scan. 
3. Select menu [Online]-[Autoscan]. 

 
 
 

Note  
At Auto Scan, only the information of the slaves whose baud rate is the same as that of the master can be obtained. 
Following information can be obtained in Auto Scan; 
1) Product code: information in the EDS file 
2) Revised version: information in the EDS file 
3) Device type: information in the EDS file 
4) Hardware version: information in the EDS file 
5) Software version: information in the EDS file 
6) Operating state: shows the operating state of the module 
7) Parameter existence: shows the existence/inexistence of module parameter 
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6.5.10   View Autoscan with Project 

The data obtained from Auto Scan are compared with the project window and displayed in network 

configuration screen. 

[Order] 

1. Select menu [Online]-[Connect]. 

2. Select the master which will conduct Auto Scan. 

3. Select menu [Online]-[Autoscan]. 

4. Select menu [Online]-[View AutoScan with Project] 

 

The operating conditions of the [View Autoscan with Project] menu are as follows; 
- Checked: the information on the project window and Auto Scan information are displayed in  

comparison. 
- Unchecked: only the existing Auto Scan information is displayed. 

 
 

Note  

The background colors of the station number indicate following information; 

1) Green: the project window and Auto Scan information are identical 

2) Red: EDS cannot be found, or the station number read by Auto Scan exists on the project but the EDS information  

is different 

3) Orange: exists in the Auto Scan information only and no parameter exists  

4) Gray: exists only in the project window 

 



 
 
 
 
Chapter 6 XG-CANopen detail menu 

 

 6-40 

6.5.11   Add Autoscan in Project 
Although not actually registered with the master(not registered project window in XG-CANopen) as a slave, 
the EDS information acquired from the Auto Scan is added in the project window.  

 
[Order] 
1. Select menu [Online]-[Connect]. 

2. Select the master which will conduct Auto Scan. 

3. Select menu [Online]-[Autoscan]. 

4. Select menu [Online]-[Add Autoscan in Project]. 

 
Delete the slave information added in the existing project window, and configure the project  
window with the data obtained from the Autoscan  

 
 

Note  
 The slave name added to project is set up “_Station No._Module name” format. 

The messages which can be generated when adding to a project are as follows; 

1) Master name is in the project after Auto Scan: master name changed, thus, cannot be added  

to the project 

2) Data obtained from previous Auto Scan are deleted from the memory: no Auto Scan data,  

thus, cannot be added to the project  

3) Slave station No. exceeds the range of 1 ~ 127: the slave station No. is invalid, thus, cannot be 

 added to the project. 
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6.5.12  Rest PLC  

PLC can be reset. PLC can be reset with the reset dip switch of the PLC too. 

 

[Order] 

1. Select menu [Online]-[Connect] to connect the PLC 

2. Select menu [Online]-[Reset PLC]. 

3. Select reset type and click Confirm button to reset the PLC. 

. 

 
 

Note  
Remember that PLC is energized again after reset 
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6.5.13  Enable Link 

Link Enable starts CANopen communication in accordance with the downloaded parameter. 

If not checked, CANopen communication doesn’t operate 

[Order] 

1. Select menu [Online]-[Connect] to connect the PLC 

2. Select menu [Online]-[Link Enable]. 

3. Select the module to conduct link enable, click the Write button. 
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6.6  Print 

6.6.1  Print Project 

This function prints the whole content of the project in order. 

The function can select the items to be printed and set up and preview the setting required for te printing, and 

perform print function. 

 

No Process Procedure 

1 

Slave Status by 
Service 

(PDO Service) 

 

1. Select menu [Project]-[Print Projects]. 

2. Print Project dialogue appears. 

3. Select the items to be printed and click [Print] button. 
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Chapter 7 Master Setting using XG-CANopen 
Edit windows of the master module(XBL-CMEA) will be displayed when double click of project widow(master module) is 
executed.  

7.1  Properties 
With the master registration information tab, the basic data of the master are set up. Registration 

information can be coarsely classified into node setting, SYNC setting, monitor setting and PLC 

reception/transmission area setting. 

 
 

7.1.1  Node setting 
1) Node name: enter name of the master node (master module) The restrictions are as follows;. 

(1) Shorter than 256 Alphabet letters.  

(2) The first letter must be an Alphabet or a Korean letter, or “_“ 

(3) The following letters can be Alphabets or Korean letters, figures or “_“ 

 
2) Station No. 

Enter station No. to the modules operating as a master, within the range of 1~127. 

 
3) Baud rate 

Enter the communication speed, within the range of 10kbps~1Mbps. 
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7.1.2  SYNC Setting 
1) SYNC messages are received only when SYNC is checked. If not checked, the data which need to be 

synchronized to SYNC for transmission cannot be transmitted. In other words, if the PDO transmission type is 
0~240, or 252, transmission cannot be carried out. 

 
2) The value of COB-ID*Note1) is SYNC h0000080 when SYNC is set up, or h00000080 when SYNC is not set up, and 

cannot be changed 

3) Cycle period must be entered within the range of 20~5000ms. 

Note  

The structure of SYNC COB-ID is as follows; 

 
The meanings of bits of the SYNC COB-ID is as follows; 

1)x: not in use. 

2)Gen: 0-CANopen device does not generate SYNC message. 1-CANopen device generates SYNC messages. 

3)frame: 0 stands for 11 bit CAN-ID (CAN basic frame), 1 stands for 29 bit CAN-ID (CAN expanded frame). 

4)The meanings of bit 0-28 differs by frame value as in the above structure. 

 

7.1.3  Monitor Setting 
Means SDO reception time out, and the input range is 200~5000ms. 

7.1.4  PLC Area 

Set up the addresses and sizes of the devices to be allocated to the objects of the mapped RPDO/TPDO 

parameters.  

Available address types are P, M, and D for type K, and I, Q, M, and D for type IEC.  

The areas are allocated to reception and transmission areas, and 48 words (XGB) are allocated for the area for 
the diagnosis variables used for monitoring communication error and monitor information. 
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7.1.5  Output data setup in case of emergency 
This function decides, in case of CPU error or CPU is changed to stop, whether the data is cleared (initialized to 
zero) or latched (maintain the last data value). 
 

7.2  Error Control Setting 
Sets up the error control related values of the master nodes and slave nodes of the CANopen network in the current 

configuration. XG-CANopen supports Heartbeat protocol and Node Guarding protocol. Newly set parameters are 

effective when Apply button is clicked. 
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7.2.1  Heartbeat Protocol Setting  
 This means the producer timeNote1) of the heartbeat protocol for the master module. 

 

7.2.2  Slave Error Control 

This is activated only when the error control protocol is selected in the slave error control setting. 

From the slave error control list, select an error control protocol for each slave. For heartbeat, enter producer 

time only, but for node guarding, enter guard time and lifetime factor, too. 

 
 

Note  
1) When setting up the heartbeat producer time, if the baudrate is 100kbps or less, the producer times  

of the master and slave must be set to 500ms or above for normal operation. 
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Note  

 
1) The error control service is used to detect the error in the CAN based networks. This is mainly implemented with 

 the message sent from CANopen device on regular basis. Two types of error control methods are available;  
Node Guarding and Heartbeat. Since the XGB CANopen master supports both heartbeat and node guarding,  
it can control error with the slaves supporting heartbeat by heartbeat method, and with the slaves supporting node 
guarding by node guarding method. 

 
2) Node Guarding 

Node Guarding is conducted by NMT (Network Management) master sending guarding request  
(RTR, Remote Transmission Request). The meanings of the guard time and node lifetime are  
as follows; 
If a slave device fails to receive the RTR from NMT master within the node lifetime, it judges that it is  
a remote node error (NMT master) and notices a life guarding event to the application. When RTR is 
received after an error occurrence, the error status is reset. 
If the master device fails to receive the reply to RTR from the slave within the node lifetime, or, reply has been 
received but the state of the NMT slave in the response frame fails to meet the expectation, it notices a node guarding 
event to the application. 

When the reply to the RTR from the slave is received after a timeout error, or the master has received expected 
NMT slave state after an error caused by NMT state, the error status is reset. 
 
▶ Guard time (or node guard time): NMT master sends RTRs to check the state of slave at constant time intervals  

which is the guard time. This can be set up differently for different slaves. 
 
▶ Node lifetime: calculated with the formula (Guard time x Lifetime Factor). This can be set up differently for different 

 slaves.  
 
3) Heartbeat 

Heartbeat producers send heartbeat messages and heartbeat consumers receive heartbeat messages. 
The heartbeat is different from guarding by that the roles of the master and slave are not divided and  
the heartbeat producers send heartbeat messages by broadcasting.  

Therefore, the message transmitted from a producer is received by multiple consumers. 
If heartbeat message is not received for a given time period, the device acting as the heartbeat producer determines 
an error.  The error status is reset when a heartbeat message is received. 
▶ Heartbeat producer time 

The period at which a heartbeat producer transmits heartbeat messages. 
▶ Heartbeat consumer time 

A heartbeat consumer judges error if it fails to receive a heartbeat message within the heartbeat consumer time.  
In the XGB CANopen master, the consumer time is not set up as a parameter but as 1.5 times of the producer 
time, internally. That is, all the slaves set the consumer time by 1.5 times of the producer time. The master also 
sets up with 1.5 times of the producer time set up in the slaves. The consumer time of master can be set up 
differently for different slaves. 
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7.3  POD Variable Table  
 

The POD Variable Table shows the names of the PDO mapping object variables set up at the slave. 

These variables can be used by XG5000.  

 
 

7.3.1  Variable 

Variables represent the mapping information per PDO object set up in the respective slave. Variables are in the 

form of: [_Base and slot positions of master module_Transmission/reception type_Sv station No._Mapped order_ Parameter 

name]. 

 
 

E.g.: _0001_Rx1_12_0_QW_001 
0001: No. 0 base o. 1 slot (in the order of Base/Slot) 
Rx1: Receive PDO1 
12: slave station No. 
0: mapped order 
_QW_001: name of the parameter declared in EDS 
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7.3.2  Device 
This means allocating the mapping information of the objects set up in slave to the master devices. To allocate 
devices automatically, select menu [View] → [Build], or execute Online → Write menu.  

 
 

7.3.3  Monitor 

This is used to monitor the master device values. Click online monitor execution to check the respective device 

value. 
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7.4  SDO Table 
SDO table shows the entire list of the SDOs which are set up to be used by the slave. Here, only monitoring of the 

SDOs set up per slave is allowed and editing is not allowed. If editing is required, use the SDO setting tab of the 
respective slave.  
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7.5  Diagnostic Variables 
This function enables to monitor the status information of the master module and slave modules. In the Diagnosis 

Variable status, select [Online] → [Start Monitoring] to monitor current states, where the meanings of the items are 
presented in the table below. The variable names consist of “Base_Slot_Variable.” Addresses are allocated 
sequentially starting from the offset address of the diagnosis variable area of the master. 96 bytes are used for each 
master. 

 

 
 

Variable Type Description 

CHANNEL_STATUS WORD 

Channel information 

BIT0=1: master is not activated 

BIT1=1: 1 or more slaves are not in Operational mode 

BIT2=1: 1 or more slaves have configuration error 

COMM_STATUS WORD 

Communication information 

BIT0=1: CAN controller “BUS Off”status 

BIT1=1: CAN controller receiver buffer overflow 

BIT2=1: CAN controller in “Error Passive”status 

BIT3=1: internal transmission queue overflow 

BIT4=1: CAN controller in  “Error Warning”status 

BIT5=1: received message exceeds CANID valid range error 

BIT6=1: internal reception queue overflow 
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Variable Type Description 

CANOPEN_STATUS WORD 

Master mode information 
0x00: initializing, or error 
0x10: Reset Node  0x20: Reset Communication 
0x30: Stop mode 
0x40: Pre-Operational mode 
0x50: Operational mode 

EVENT_STATUS WORD 

Event information 
BIT0=1: PUTCOMM, GETCOMM, read present screen only, read 
all, Reset if error occurs during Writing SDO and cleared if 
successful with the latest command. 
BIT1=1: Error*5 occurred during communication process  
BIT2=1: when the slaves set up with the parameter differ 

 from those on the network. 
BIT3=1: among the slaves set up with error control,  

1 or more nodes failed error control 
MASTER_CYCLE_MIN WORD Master cycle min. value (ms) 
MASTER_CYCLE_CUR WORD Master cycle current value (ms) 
MASTER_CYCLE_MAX WORD Master cycle max. value (ms) 

GENERIC_ERR_CNT WORD 
Count of generic errors. 
Count of the received emergency messages having codes 10xxH 

DEVICE_HARD_ERR_C
NT 

WORD 
Count of device hardware errors 
Count of the received emergency messages having codes 50xxH 

DEVICE_SOFT_ERR_C
NT 

WORD 
Count of device software errors 
Count of the received emergency messages having codes 60xxH 
61xxH, 62xxH, 63xxH 

COMMUNICATION_ER
R_CNT 

WORD 
Communication error count 
Count of the received emergency messages having codes 81xxH 

PROTOCOL_ERR_CNT WORD 
Protocol error count 
Count of the received emergency messages having codes 82xxH 

EXTERNAL_ERR_CNT WORD 
Count of external errors. 
Count of the received emergency messages having codes 90xxH 

DEVICE_SPEC_ERR_C
NT 

WORD 
Count of device-specific errors 
Count of the received emergency messages having codes FFxxH 

SLAVE_NUM BYTE No. of the slaves set up in parameter (max.: 32)  
Reserved 3*BYTE Reserved  

SLAVE_ID_0 ~ n BYTE ID of the slaves set up in parameter (1 ~ 127)  

SLAVE_INFO_0 ~ n BYTE 

BIT0=1: slave configuration progress completed 
BIT1=1: slave configuration error 
BIT2=1: when slave EMCY error exists 

 (Cleared if the latest recorded Emcy is h8140, 0x00xx) 
BIT3=1: Init status 
BIT4=1: Stop mode 
BIT5=1: Pre-Operational mode 
BIT6=1::Operational mode 
BIT7: Reserved 
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Note  

  
1) CHANNEL_STATUS: master module’s channel information  
   a) BIT0: 1 if stack initialization error, 0 if initialization normal Set to 1 at reset, link inactive,  

or parameter downloading, then set to 0 after parameter download success or link becomes 
active, after stack initialization.  

   b) BIT1: 1 if 1 or more slaves set up in the parameter have non-operational modules, or 0 when  
all the slaves set up in the parameter are operational. (If the BIT6 of SLAVE_INFO_n is 1, 
 the status is “Operational.”) 

   c) BIT2: 1 if 1 or more slaves set up in the pmt have modules having configuration errors, 0 otherwise.  
(If the BIT1 of SLAVE_INFO_n is 1, the status is “Configuration error.”) 

2) CHANNEL_STATUS: master module’s communication status information  
   a) BIT0: 1 if the CAN controller is “Bus Off” status 

Occurs when TEC (Transmit Error Counter) is 256 or more. 
   b) BIT1: 1 if CAN controller receiver buffer overflow 
           This occurs when another message is received before the received message in the CAN controller  

buffer is read 
c) BIT2: 1 if the CAN controller is in “error passive” status 

           This occurs when TEC (Transmit Error Counter) or REC (Receive Error Counter) is 128 or more. 
d) BIT3: 1 if internal transmission queue overflow. 

        This occurs when other data is added to the transmission queue of the master before transmitting data. 
e) BIT4: 1 of the CAN controller is in “error warning” status. 

           This occurs when TEC (Transmit Error Counter) or REC (Receive Error Counter) is 96 or more. 
f) BIT5: 1 if the CAN ID exceeds the range. 

           This occurs when the CAN ID of the received message is not extended id and h800 or above,  
and not h801 (error no event). 

g) BIT6: 1 if internal reception queue overflow. 
          This occurs when other data is added to the receiver queue of the master before receiving the data. 
3) CANOPEN_STATUS: master status information 

a) h0000: Master Init or Error. Master stack’s initial status or error status. 
b) h0010: Reset Node. Module reset, after parameter downloading, master status is changed to node reset status. 
c) h0020: Reset Communication. After node reset completed. Changed to communication reset status. 

In this status, Communication objects are initialized. 
d) h0030: Stop status 
e) h0040: Pre-Operational status 
f) h0050: Operational status 

4) EVENT_STATUS: event status information  
a) BIT0: 1 if the error occurred at SDO transmission exists, otherwise, set to 0. 

           1 if error occurs during PUTCOMM, GETCOMM, read current screen only, read all, or writing SDO, 
 or 0 if the latest command succeeds.  

b) BIT1: error occurred during communication: 1 if the slave is set up with mapping parameter or comes 
 under anyone of the following cases during communication, 0 otherwise. 

- Count 8 which is the maximum number for mapping is exceeded 
- 64 bits which is the entire mapping size is exceeded 
- Set up object cannot be mapped 
- Access right is illegal 
- Object type or size is different 
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- Object does not exist 
c) BIT2: 0 if the nodes set up in the parameter and network coincide, 1 otherwise. 
d) BIT3: 1 if guarding or heartbeat error has occurred, 0 otherwise. 

5) MASTER_CYCLE_MIN: min. scan cycle time in the master module (ms) 
6) MASTER_CYCLE_CUR: current scan cycle time in the master module (ms) 
7) MASTER_CYCLE_MAX: max. scan cycle time in the master module (ms) 
 
Under 8) ~ 14), at each reception of Emcy event from slave, the respective error count is increased according to the 
error code range. 
 
8) GENERIC_ERR_CNT: generic error count. No. of the received Emcy messages having the error codes of 10xxH. 
9) DEVICE_HARD_ERR_CNT: device hardware error count, No. of the received Emcy messages having the  

error codes of 50xxH. 
10) DEVICE_SOFT_ERR_CNT: device software error count, No. of the received Emcy messages having  

the error codes of 60xxH, 61xxH, 62xxH, and 63xxH. 
11) COMMUNICATION_ERR_CNT: communication error count, No. of the received Emcy messages having  

the error codes of 81xxH. 
12) PROTOCOL_ERR_CNT: protocol error count, No. of the received Emcy messages having  

the error codes of 82xxH. 
13) EXTERNAL_ERR_CNT: external error count, No. of the received Emcy messages having  

the error codes of 90xxH. 
14) DEVICE_SPEC_ERR_CNT: Device-specific error count, No. of the received Emcy messages having  

the error codes of FFxxH. 
15) SLAVE_NUM: No. of the slaves set up in the parameter (max. 32) 
16) SLAVE_ID_n: n-th slave set up in the parameter ID (1~127) 
17) SLAVE_INFO_n:status to SLAVE_ID_n 

a) BIT0: slave configuration completed, PDO mapping parameter and SDO default value downloading  
have been completed and SDO write, read, Auto Scan, and XG5000 command execution  
are possible. When the value is 0, SDO write, read, Auto Scan and , XG5000 command request 
are processed as an error. 

b) BIT1: slave configuration error, meaningful only when BIT0 is 1.  When the BIT0 is 1, the value is 0 
           If the slave node status is Operational, or 1 if it is not Operational and judged to be normal configuration  

has failed. 
c) BIT2: slave EMCY error occurred 

           Referring to the slave history (stored up to latest 5 per slave), 1 if there is saved error(s) and the latest error 
   code is neither 00XXh (Error reset or no error) nor h8140, 0 if there is no saved error or the latest error code 

 is either 00XXh (Error reset or no error) or h8140. 
d) BIT3: Init status. 1 if configuration has not been completed, or the status is not Stop, Pre-Operational,  

or Operational, 0 otherwise. 
e) BIT4: Stop mode. 1 if in Stop status, 0 otherwise. 
f) BIT5: Pre-Operational mode. 1 if in Pre-Operational status, otherwise 0. 
g) BIT6: Operational mode. 1 if in Operational status, otherwise 0. 
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Note  

  

* In the above Note 8) ~ 14), the Emcy errors received from XBL-CSEA are as presented in the table below. 

 
 

Error Code Classification Error Code Remark 

COMMUNICATION_ERR_CNT 

0x8110 
Los of message occurred due to CAN controller receiver buffer 
overflow, or internal transmission/reception queue overflow 

0x8120 CAN controller is in “Error Passive” status 
0x8130 Heartbeat error has occurred 
0x8140 CAN controller has recovered from “Bus Off” status 

0x8150 
Invalid COB-ID has been received. The message is not 
processed. 

PROTOCOL_ERR_CNT 

0x8210 
PDO was not processed as a length error. Length of the received 
PDO is shorter than the initial mapping value 

0x8220 
Length of the received PDO is longer than the initial mapping 
value The PDO data are processed. 

0x8240 

SYNC data length error. Since the CSEA does not support SYNC 
counter, judges an error if the dlc (data length counter) of the 
received SYNC message is not 0, and does not process the 
SYNC message. 

 
Note  

When the Error Clear button is selected in the Diagnosis Device, following items are cleared; 
1) COMM_STATUS 

BIT3=1: internal transmission queue overflow 
BIT5=1: received message exceeds CANID valid range error 
BIT6=1: internal reception queue overflow 

2) EVENT_STATUS 
BIT0=1: error occurred during SDO transmission 
BIT1=1: Error occurred during communication process  

3) MASTER_CYCLE_MIN, MASTER_CYCLE_CUR, MASTER_CYCLE_MAX 
4) GENERIC_ERR_CNT, DEVICE_HARD_ERR_CNT, DEVICE_SOFT_ERR_CNT, COMMUNICATION_ERR_CNT, 

PROTOCOL_ERR_CNT, EXTERNAL_ERR_CNT, DEVICE_SPEC_ERR_CNT 
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Chapter 8 Slave Setting using XG-CANopen 
The slave setting window consists of registration information, error control setting, SDO setting, PDO setting and PDO mapping. 

Edit windows of the Slave module will be displayed when double click of project widow(Slave module) is executed.  
 

8.1  Properties 
With the slave Properties tab, the basic data of the slave are set up.  

The Properties consist of station No., name, module name, EDS and description. 

 
[Figure 8.1.1] Slave Setting 

8.1.1  Station No. 
A slaves must have a unique station number, ranging from 1 to 127, within the network.  

 

8.1.2  Name 

Name of the slave assigned by the user. The name must be unique to identify the slave. Like the 

master node. Slave names have restrictions. It length must not exceed 20 Alphabets, with the first 

letter in an Alphabet or Korean alphabets, or “_” followed by Alphabets or Korean alphabets, figures, 

or “_.” 

 

8.1.3  Module 

Moules(porduct name) specified in the EDS file of the slave. Automatically entered when the EDS 

file is selected, and cannot be changed. 
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8.1.4  EDS 

Shows the EDS file path selected by the user from library. EDS file can be changed using the [...] 

button to the right. 

 

8.1.5  Description 
Enter the description of the slave node. Allowable length is 256 bytes(128 Korean letters, 256 Alphabets) of any 
character. 
 

When registration information has been modified, click the Apply button to apply the cahnge. 
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8.2  Error control setting 
Select error control method for the slave module. When the slave error control setting button is clicked, 

following screen will appear.  

The error control service is used to detect the error in the CAN based networks. This is mainly 

implemented with the message sent from CANopen device on regular basis. Two types of error control 

methods are available; Node Guarding and Heartbeat protocols. Since the XGB CANopen master 

supports both heartbeat and node guarding, it can control error with the slaves supporting heartbeat by 

heartbeat method, and with the slaves supporting node guarding by node guarding method. 

 

 

[Figure 8.1.2 Error control setting window 
 

8.2.1  Node Guarding 

Node Guarding is conducted by NMT(Network Management) master sending guarding request(RTR, 

Remote Transmission Request). The meanings of the guard time and node lifetime are as follows;  

If a slave device fails to receive the RTR from NMT master within the node lifetime, it judges that it is a remote 

node error(NMT master) and notices a life guarding event to the application. When RTR is received after an 

error occurrence, the error status is reset. 

If the master device fails to receive the reply to RTR from the slave within the node lifetime, or, reply has been 

received but the state of the NMT slave in the response frame fails to meet the expectation, it notices a node 

guarding event to the application. 

When the reply to the RTR from the slave is received after a timeout error, or the master has received expected 

NMT slave state after an error caused by NMT state, the error status is reset.  
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▶ Guard time (or node guard time): NMT master sends RTRs to check the state of slave at constant  

time intervals which is the guard time. This can be set up  

differently for different slaves. 

▶ Node lifetime: Calculated with the formula (Guard time x Lifetime Factor). This can be set up differently for  
different slaves.  

 

8.2.2  Heartbeat 

Heartbeat producers send heartbeat messages and heartbeat consumers receive heartbeat messages. The 

heartbeat is different from guarding by that the roles of the master and slave are not divided and the heartbeat 

producers send heartbeat messages by broadcasting. Therefore, the messages transmitted from a producer is 

received by multiple consumers. 

If heartbeat message is not received for a given time period, the device acting as the heartbeat producer 

determines an error. The error status is reset when a heartbeat message is received.  

▶ Producer time: the period at which a heartbeat producer transmits heartbeat messages. 
 
 

Note  
 
Error control setting of our CANopen slave module(XBL-CSEA) supports only heartbeat protocol. 
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8.3  SDO setting 
SDO (Service Data Object) transmission is mainly used to set up the initial values of the devices in the CANopen 

network. The priority level is low and non-periodic. The objects are classified into 16 bit indexes and 8 bit sub-indexes. 

 

8.3.1  Objects 

Shows all the object information recorded in the EDS. For each cell, the [Setting Value] and [Use] cells are 

activated for editing when the access attribute is RW, and inactive otherwise. 

If the user checks the check-box of the Use cell and setup the current value, the setting value is transferred to 

the respective object when the slave starts operation. 

 

1) Index: the objects in the Object Dictionary are searched using 16 bit indexes. 

2) Sub-index: the 8 bit values used for searching the records in the objects. 

3) Parameter name: the text string describing an object. 

4) Data type: a Table presents the types of all the data. 

5) The data types used in the XBL-CSEA are 4 type of; 5 (UNSIGNED8), 6 (UNSIGNED16), 7 (UNSIGNED32),  
and 9 (VISIBLE_STRING) 

6) Setting value: enter the value of the object item checked for use. Entered values are stored in the parameter when 
the project is saved. 



 

 

 

 
Chapter 8 Slave Setting using XG-CANopen 

 

 8-6 

7) Access attribute: the attribute of the object accessibility. For example, writing is allowed by W (Write) attribute. 

Access Attribute Description 

RW Read/Write access allowable 

WO Write Only 

RO Read Only 

CONST Read Only, constant value 

RWW Read/Write accessibility to process output 

RWR Read/Write accessibility to process input 

 

8) Use: select use or no use. If checked, registered with the SDO table of the master module. 

 

8.3.2  Write SDO 

Write SOD can be conducted in the 3 methods as follows; 

1) Write after module initialization: The value entered into the setting value is downloaded at the 

time of parameter writing, and the n downloaded to slave device from the master, when the slave 

id initialized. At this time, the setting value can be entered both online and offline.  

2) Writing in operation: this function enables SDO parameter writing during normal operation. SDO 

writing window appears when Online → Write SDO is selected, or right click the mouse on the 

setting value and select Write SDO from the context menu. Check the object index and sub-index, 

enter value and click Write after Input, Write SDO is completed. The result of writing can be 

checked by selecting Read All Screens or Read Current Screen menu. Writing in operation is 

applicable in online mode only. 
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3) Write SDO using instruction 

GETCOMM and PUTCOMM commands are used to write and read SDO. For further details, see section 

[8.4, SDO Command]. 

 

8.3.3  Index 
The function to search the index presented in the object list of the EDS. Write the index to be searched and 
select [GO to] button. 

 

8.3.4  Format 
Select decimal or hexadecimal system to express object list and minimum and maximum values. 

 

8.3.5  Minimum/Maximum 

Refer to the minimum and maximum values of the object selected from the object list. When editing 

the value in the Current Value cell, if the value exceeds the min./max. value range, an error 

message is triggered. 

 

8.3.6  Number of SDOs 
Show the maximum number of available SDOs and the number of currently set-up SDOs. The maximum 
number is the maximum that can be set up in the master module. 

 

8.3.7  Size of SDOs  
Show the maximum size of available SDOs and the size of currently set-up SDOs. The maximum SDO 
capacity is the largest capacity that can be set up in the master module. 
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8.3.8  Writeable Object list when XBL-CSEA is selected 

Index 
Sub 
index 

Parameter name Data type 
Access 
property 

Min. Max 

h1003 h00 Number of elements UNSIGNED8 RW h00 h00 
h1005 h00 COB-ID SYNC message UNSIGNED32 RW - - 

h1010 h01 
Parameters that may be stored 

on the CANopen device 
UNSIGNED32 RW - - 

h1011 h01 Restore all default parameters UNSIGNED32 RW - - 
h1014 h00 COB-ID Emergency Object UNSIGNED32 RW - - 
h1015 h00 Inhibit time EMCY UNSIGNED16 RW - - 
h1016 h01 Consumer heartbeat time  1 UNSIGNED32 RW - - 
h1017 h00 Producer Heartbeat Time UNSIGNED16 RW h0000 hFFFF 
h2000 h01-h80 %QW 001 - %QW 128 UNSIGNED16 RWW h0000 hFFFF 
h2010 h01-h80 %QW 129 - %QW 256 UNSIGNED16 RWW h0000 hFFFF 
H2100 h01-h80 %IW 001 - %IW 128 UNSIGNED16 RO h0000 hFFFF 
h2110 h01-h80 %IW 129 - %IW 256 UNSIGNED16 RO h0000 hFFFF 

 
▶ h1003: Pre-defined error field 

This object provides the error occurred in the CANopen device. The sub-index 0 present the number of 
error stored from sub-index 1. XBL-CSEA can store up to 10 errors. Only the sub-indexes whose values 
are stored in the sub-index 0 can be read. For example, if the value is 0 which means there has been no 
error, reading sub-index value of 1 or higher gives an error message. Wrting 0 into the sub-index 0 will 
delete the entire error history. Other values than 0 are not allowed to write in. 

 
▶ h1005: SYNC message COB-ID(COB-ID SYNC message) 

The SYNC COB-ID can have two values of; h40000080 at SYNC creation, or h00000080 when SYNC is 
not created. Since SYNC creation exists only one on a network, if there is a master, only h00000080 is 
allowed.  
 

▶1010: Store parameters 
The object enables storing parameters in non-volatile memory. To prevent saving parameter by mistake, 
the object can be activated by a specific sign value. The recognizable sign value is “save” as shown below. 
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▶ h1011: Restore default parameters 

 The parameter values stored in the flash memory are deleted and the default parameter values kept in 
the module are restored. To prevent restoring to default parameter by mistake, the object can be activated 
by a specific sign value. The recognizable sign value is “load” as shown below. 

 
 

▶h1014: EMCY COB-ID(COB-ID EMCY) 
The COB-ID configured for emergency writing service. When the object uexists and the valid is 1, the bit 0-
29 is not changed. 

 
▶ h1015: EMCY (Inhibit time EMCY) 

Even when an EMCY has occurred, no message is transmitted until the inhibit time has not been elapsed 
after sending a previous EMCY message. The default value is a multiple of 100u㎲, and 0 inactivates the 
inhibit time. Allowable setting range is h000~hFFFF. 
 

▶ h1016: Consumer heartbeat time 
The structure of the consumer heartbeat time is as shown below. When XBL-CMEA is used as a master, 
enter the node ID of the master as the Node-ID. The setting range of the heartbeat time is a h0000~hFFFF, 
and a multiple of 1㎳. If h0000 is set, the consumer heartbeat becomes inactive. 

                   

 
 
▶h1017: Producer heartbeat time 

 The setting value is a multiple of 1ms, and h0000 inactivates the producer heartbeat 
 

▶ h2000, h2010: equivalent to the storage field (RPDO) of our slave module. 

When the settings are as shown in the dialog shown below, the sub-index 1 of the object h2000 
corresponds to the word address D00000 field, and the sub-index h80 corresponds to D00127. The sub-
index 1 of the object h2010 points at the word address D00128, and the sub-index h80 points at D00255.  
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▶ Object h2000, h2010: equivalent to the storage field (TPDO) of our slave module. 

When the settings are as shown in the dialog shown below, the sub-index 1 of the object h2100 
corresponds to the word address M00000 field, and the sub-index h80 corresponds to M00127. The sub-
index 1 of the object h2110 points at the word address M00128, and the sub-index v h80 points at 
M00255. 
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8.4  SDO Command 
The SDO command can be classified into GETCOMM and PUTCOMM, which are for reading and writing, respectively. 
The commands canbe set up for only one sub-index. 

8.4.1  GETCOMM 
▶ Using in the XBM,XBC Series 

Command 
Device 

Step 
Flag 

PMK F L T C S Z D.x R.x 
Con
st. 

U N D R 
error 

(F110) 
zero 

(F111) 
carry 

(F112) 

GETCOMM 

sl - - - - - - - - - O - - - - 

4~7 O - - 
S O - O - - - - - - - O O O O 
D O - O - - - - - - - O O*1) O O 
N O - O - - - - - - O O O O O 

 

 
 

[Field Setting] 
Operand Description Data size 

sl 
No. of the slot where communication module is installed  
(set up with hexadecilmal number) 

WORD 

S Station number of the slave to be read, SDO index/sub-index WORD 
D Starting address of the device where the data read from slave is to be stored WORD 

N 
Max. bytes of the data to be read from communication module. The actual data are 
from after N (total size)-8. 

WORD 

[Flag Set] 
Flag Description Device No. 

PUTCOMM/ 
GETCOMM  

Error 

- If no communication module, the bit of the slot turns ON 
- If the PUTCOMM/GETCOMM command failed to be executed properly, the bit 

turns ON 

F0015 
Bit14 of D 

PUTCOMM / 
GETCOMM  
Complete 

- If normal response is received from the corresponding communication module, the 
bit turns ON 

F0023 
Bit15 of D 

 
1) This command is for reading the data of the corresponding device via communication module. 
2) In the communication module designated with sl (slot No. of the communication module), send 6 byte command 

data from the internal device field designated with S to the communication module, and save the return result of the 
communication module in the internal device field designated by operand D. Here, the maximum allowable 
reception byte is N. 

3) If there is no communication module at the position pointed by sl (slot No. of communication module), or the 
GETCOMM command has failed to be executed properly, the respective location bit of the 
PUTCOMM/GETCOMM error flag F0015 (WORD) is set. 
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4) Ths command is not processed in scan synchronous manner. That is, the response from the corresponding device 
may arrive after several scans, the result cannot be known right after processing the command . 

5) Process result check can be confirmed with flag. 
6) sl (slot No, of communication module) is set up with two digits in hexadecimal, and if h0002 as shown in the figure 

below, the h0002 refers to the slot No. 
7)  (S + 8)Byte or (D + N)Byte exceeds the range, F110 and F115 bits are set. 

 
▶ Exemplary application of  GETTCOM 

The exemplary software program below reads 4 bytes of data from the index h2000 and h0072 sub-index of the 

slave station 1, CANOpen master module installed in slot No. 2, and save the data in D6300.. 

 

 
 
▷ Meanings of the operands 

1) sl(h0002): base No. 00, slot No.02 
2) S(D1000~D1003): slot and object index 

Device Bit[15-8] Bit[7-0] Address 
Allocation 

S + 0 - Station No. of Slave D1000 

S + 1 Slave-side object index (High) Slave-side object index (Low) D1001 

S + 2 - Slave-side object sub-index  D1002 

S + 3 Reserved Reserved D1003 

 
3) D(6300~D6304) 

Device Bit[15-8] Bit[7-0] Address 
Allocation 

D + 0 NDR(Bit15), ERR(Bit14) - D6300 

D + 1 Length(High)- Length(Low) D6301 

D + 2 Error Code(High) Error Code(Low) D6302 

D + 3 Reserved Reserved D6303 

D + 4 Data0 Data1 D6304 

4) N (10): total data length. Pure data length is 2 bytes of N-8 
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▶ Using in the XEC Series 
 

Function Block Description 

 

UINT

GETCOMM  

DONE

BASE

SLOT

NODE_ID

STAT

BOOL

USINT

USINT

REQBOOL

DATA
ARRAY OF 
BYTE

USINT

MADDRUDINT

SIZEUINT

 
 

Input 
 REQ : executes the function in case of 1 
 BASE: No. of Base installed with the communication 

 module 
 SLOT: No. of Slot installed with the communication 

 module 
 
 NODE_ID: Station No. of Slave(1 ~ 127) 

 MADDR: SDO index/sub-index of the slave to be read
 DATA: Address of the device where the data read 

 from slave is to be stored  
(ARRAY of BYTE) 

 SIZE: Data size(1 ~ 512 byte) 
 

Output  
DONE: If normal response is received from  

the corresponding communication module, the bit  
turns ON 

 STAT : Error code 

[Flag Set] 

Flag Description Device No. 

PUTCOMM/ 

GETCOMM  

Error 

- If no communication module, the bit of the slot turns ON 

- If the PUTCOMM/GETCOMM command failed to be executed properly, the bit 

turns ON 

F0015 

Bit14 of D 

PUTCOMM / 

GETCOMM  

Complete 

- If normal response is received from the corresponding communication module, 

the bit turns ON 

F0023 

Bit15 of D 

 

1) This command is for reading the data of the corresponding device via communication module. 
2)  In the communication module designated base and slot No., send designed command to module and save  

the return data from  the communication module . Then the maximum allowable reception byte is SIZE 
3) This command is not processed in scan synchronous manner. That is, the response from the 

 corresponding device may arrive after several scans, the result cannot be known right after 
processing the command . 

4)  If SIZE is over the data array length, do not execute the command.  
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▶ Exemplary application of  GETCOMM: 

The exemplary software program below reads 4 bytes of data from the index h2000 and h0056 sub-index of the 

slave station 1, CANOpen master module installed in slot No. 2, and save the data in data array variable. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
1) BSAE:  base NO. of master (0) 
2) SLOT:  slot NO. of master (2) 
3) NODE_ID: station NO. of slave(2) 
4) MADDR: OD Index(2000),Sub-Index(0056) of slave 

Variable Description Variable Description 
High word OD index Low word Sub index 

 
5) DATA: read data of slave(Data0, Data1) 

Variable Description Variable Description 
data[1] Length(High) data[0] Length(Low) 
data[3] Data0 data[2] Data1 

 
6) SIZE: Data length(byte): data length(2byte)+ data(2byte) 
7) DONE: Status of command 
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8.4.2  PUTCOMM 
▶ Using in the XBM,XBC Series 

 

Command 
Device 

Step 
Flag 

PMK F L T C S Z D.x R.x 
Con
st. 

U N D R 
error 

(F110) 
zero 

(F111) 
carry 

(F112) 

PUTCOMM 

sl - - - - - - - - - O - - - - 

4~7 O - - 
S O - O - - - - - - - O O O O 
D O - O - - - - - - - O O*2) O O 
N O - O - - - - - - O O O O O 

 

 
 
[Field Setting] 

Operand Description Data size 

sl 
No. of the slot where communication module is installed (set up with hexadecilmal 
number) 

WORD 

S Station number of the slave to be read, SDO index/sub-index WORD 
D Starting address of the device where the data read from slave is to be stored WORD 

N 
Max. bytes of the data to be read from communication module. The actual data are 
from after N (total size)-8. 

WORD 

 
[Flag Set] 

Flag Description Device No. 
PUTCOMM/ 
GETCOMM  

Error 

- If no communication module, the bit of the slot turns ON 
- If the PUTCOMM/GETCOMM command failed to be executed properly, the bit turns 

ON 

F0015 
Bit14 of D 

PUTCOMM 
/ 

GETCOMM  
Complete 

- If normal response is received from the corresponding communication module, the 
bit turns ON 

F0023 
Bit15 of D 

 
1) This command is for writing data in the corresponding device via communication module. 
2) In the communication module designated with sl (slot No. of the communication module), send 6 byte command 

data from the internal device field designated with S to the communication module, and save the return result of the 
communication module in the internal device field designated by D. 

3) If there is no communication module at the position pointed by sl (slot No. of communication module), or the 
PUTCOMM command has failed to be executed properly, the respective location bit of the F0015 (WORD) is set. 

4) The command is not processed in scan synchronous manner. That is, the response from the corresponding device 
may arrive after several scans, the result cannot be known right after processing the command . 
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5) Process result check can be confirmed with flag. 
6) sl (slot No, of communication module) is set up with two digits in hexadecimal, and if h0002 as shown in the figure 

below, the 0002 refers to the slot No. 
7)  (S + N)Byte or (D + 8)Byte exceeds the range, F110 and F115 bits are set. 

 

▶ Exemplary application of PUTCOMM: 

The exemplary software program below writes 2 bytes of data from the index h2000 and h0072 sub-index of the 

slave station 1, CANOpen master module installed in slot No. 2. 

 
 
▷ Meanings of the operands  

1) sl(h0002): Base No 00, Slot No 02 
2) S(D1000~D1004): slot and object index, data 

Device Bit [15-8] Bit [7-0] 
Adddress 
Allocation 

S + 0 - Station No. of corressponding device D1000 

S + 1 Slave-side object index (High) Slave-side object index (Low) D1001 

S + 2 - Slave-side object sub-index  D1002 

S + 3 Reserved Reserved D1003 

S + 4 Data0 Data1 D1004 

 
3) D(7000~D7003): Result of command 

Device Bit [15-8] Bit [7-0] Adddress 
Allocation 

D + 0 NDR (Bit15), ERR (Bit14) - D7000 

D + 1 Length (High)- Length (Low) D7001 

D + 2 Error Code (High) Error Code (Low) D7002 

D + 3 Reserved Reserved D7003 

4) N (10): total data length. Pure data length is 2 byte by N-8  
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▶ Using in the XEC Series 
 

Function Block Description 

 

UINT

PUTCOMM  

DONE

BASE

SLOT

NODE_ID

STAT

BOOL

USINT

USINT

REQBOOL

DATA
ARRAY OF 
BYTE

USINT

MADDRUDINT

SIZEUINT

 
 

Input 
 REQ : executes the function in case of 1 
 BASE: No. of Base installed with the communication 

 module 
 SLOT: No. of Slot installed with the communication 

 module 
 
 NODE_ID: Station No. of Slave(1 ~ 127) 

 MADDR: SDO index/sub-index of the slave to be read
 DATA: Writing data (ARRAY of BYTE) 
 SIZE: Data size(1 ~ 512 byte) 
 

Output  
DONE: If normal response is received from  

the corresponding communication module, the bit  
turns ON 

 STAT : Error code 
 

 

1) This command is for reading the data of the corresponding device via communication module. 
2)  In the communication module designated base and slot No., send designed command to module and save  

the return data from  the communication module . Then the maximum allowable reception byte is SIZE 
3) This command is not processed in scan synchronous manner. That is, the response from the 

 corresponding device may arrive after several scans, the result cannot be known right after 
processing the command . 

4)  If SIZE is over the data array length, do not execute the command.  
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▶ Exemplary application of PUTCOMM: 

The exemplary software program below writes 2 bytes of data from the index h2000 and h0056 sub-index of the 

slave station 1, CANOpen master module installed in slot No. 2. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1) BSAE:  base NO. of master (0) 
2) SLOT:  slot NO. of master (2) 
3) NODE_ID: station NO. of slave(2) 
4) MADDR: OD Index(2000),Sub-Index(0056) of slave 

Variable Description Variable Description 
High word OD index Low word Sub index 

 
5) DATA: write data of slave(Data0, Data1) 

Variable Description Variable Description 
data[1] Length(High) data[0] Length(Low) 
data[3] Data0 data[2] Data1 

 
6) SIZE: Data length(byte): data length(2byte)+ data(2byte) 
7) DONE: Status of command 
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8.4.3  Meanings of the Error Code for XBM, XBC series 

 Symbol Code Description 

COMM_ERR_SUCCESS 0x0000 Executed successfully 
COMM_ERR_IF_TIMEOUT 0x8001 Timeout error (no response for 5 s between the basic and link module) 
COMM_ERR_NODEID 0x8002 The station No. of the corresponding device is not within 1~127. 

COMM_ERR_LENGTH 0x8003 
1. SIZE is small than 1 or bigger than 520. 
2.Receviced byte No. for GETCOMM command is over max. byte 
size 

COMM_ERR_SUBINDEX 0x8004 The sub-index is bigger than 255 

COMM_ERR_SDO_WRITE_FAIL 0x8005 
In the PUTCOMM command, failed to stack on the stack queue due 
to queue overflow 
-Data overload, adjust the communication load. 

COMM_ERR_SDO_READ_FAIL 0x8006 
In the GETCOMM command, failed to stack on the stack queue due 
to queue overflow 
-Data overload, adjust the communication load. 

COMM_ERR_NOT_READY 0x8007 
The slave is not ready for service yet 
-Check the installment of slave 

COMM_ERR_MASTER_NOT_READY 0x8008 

The master module is not ready for service yet 
-Check the Link-Enable of master module, or master module is 
initializing parameter 
-Edit program(It need to execute command just few second ago) 

SDO_ERR_WRITE_FAIL 0xF001 

1.SDO Write error occurred at stack(limited for PUTCOMM) 
- Station No. error of slave module or NAK response from slave 
- NAK response occurrences unsupported index(sub-index)of the 
slave or data length is in discard with object length of the slave. 

SDO_ERR_READ_FAIL 0xF002 

SDO Read error occurred at stack(limited for GETCOMM) 
Station No. error of slave module or NAK response from slave 
- NAK response occurrences unsupported index(sub-index)of the 
slave  

SDO_ERR_TIMEOUT 0xF003 Reached to the communication module, but time out occurred 
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8.4.4  Meanings of the Error Code for XEC series 

Status Description 
0x0000 Executed successfully 

0x0001 
Base No. setting error 
- Check the base( In case of XGB series, Base No. is always 0 

0x0003 The slave No. is over 
0x0004 Set module at slot is not installed  
0x0005 Installed module is not matched 
0x0006 Size is over about Data  Array size 

0x000A 
Next command is executed despite existing uncompleted command  
Command of CANopen is possible to run one command per 1 scan. 

0x8001 Timeout error (no response for 5 s between the basic and link module) 
0x8002 The station No. of the corresponding device is not within 1~127. 

0x8003 
1. Size is small than 1 or bigger than 520. 
2.Recevice byte No. for GETCOMM command is over max. byte size 

0x8004 The sub-index is bigger than 255 

0x8005 
In the PUTCOMM command, failed to stack on the stack queue due to queue overflow 
-Data overload, adjust the communication load. 

0x8006 
In the GETCOMM command, failed to stack on the stack queue due to queue overflow 
-Data overload, adjust the communication load. 

0x8007 
The slave is not ready for service yet 
-Check the installment of slave 

0x8008 
The master module is not ready for service yet 
-Check the Link-Enable of master module, or master module is initializing parameter 
-Edit program(It need to execute command just few second ago) 

0xF001 

1.SDO Write error occurred at stack(limited for PUTCOMM) 
- Station No. error of slave module or NAK response from slave 
- NAK response occurrences unsupported index(sub-index)of the slave or data length is in 
discard with object length of the slave. 

0xF002 

SDO Read error occurred at stack(limited for GETCOMM) 

Station No. error of slave module or NAK response from slave 

- NAK response occurrences unsupported index(sub-index)of the slave  

0xF003 Reached to the communication module, but time out occurred 
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8.5  PDO Setting 
All the nodes (slaves) have the PDOs (Process Data Objects) containing the actual process data.  

In the CANopen, classified into Receive PDO and Transmit PDO. In the view point of node (slave), the Transmit PDO 

are the data generated by nodes and Receive PDO are the data consumed by nodes. In the view point of the master, 

the Receive PDO contains the process output data transmitted to the nodes, and the Transmit PDO contains the input 

process data received from the nodes. 

In PDO setting, the PDOs used by the slaves are set up. 

 

8.5.1  PDOs (Process Data Objects) defined in the EDS file 

Shows all the PDOs recorded in the EDS. To set up PDO, select the check box or click the arrow key. 
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8.5.2  PDO Setting 

The PDOs to be used are displayed.  

Transmission type and transmission type NO., Inhibit time, Event timer are set up here.  

1) Transmission type 

Transmission Type Type No. Description 

Synchronous acyclic 0 
Synchronous, acyclic, periodic transmission only when the data is 
changed 

Synchronous cyclic 1-240 
Synchronous, transmission periodically when the SYNC of the 
transmission type value is received 

Reserved 241~251 Reserved 

Synchronous RTR-only 252 Only when RTR is received (RTR-only), synchronous 

Asynchronous RTR-only 253 Only when RTR is received (RTR-only), event driven 

event-driven, 
manufacturer specific 

254 Event-driven, Manufacturer specific*Note1 

event-driven,  
profile specific 

255 Event-driven, device profile and application profile are unique*Note1 

 
(1) PDO Transmission mode  
 PDO transmission modes are classified as follows;. 
   a) Synchronous transmission 
   b) Event-driven transmission 
 
(2) PDO start-up mode are as follows;  

a) Event-and time-driven 
Messages are transmitted by the events unique to the application as specified in the device profile or 
application profile, or unique to the manufacturer. Or transmitted after a certain time (event-time) without an 
event. 
 
b) Remotely requested 
The event-driven transmission of PDO starts on receiving the RTR initiated by PDO consumer. 
 
c) Synchronously triggered 
 Message transmission is triggered by generation of SYNC object. The trigger conditions are No. of 
SYNC and selective internal event. 

 
 (3) TPDO transmission type 

a) The term synchronous means that the PDO is transmitted after the SYNC object.  
On receiving SYNC, the CANopen devices starts data sampling. If acyclic, sampling begins 

at the next SNC after triggering of CANopen device internal event, followed by PDO 
transmission.  
In case of cyclic, sampling begins when receiving from 1 to 240 SYNC according to the transmission type 
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value, followed by PDO transmission. 
 
b) Only when RTR is received  
RTRPDO is not transmitted in normal situation, except when RTR has been received. If the transmission 
type is 252, the CANopen devices begins sampling at each reception of SYNC to buffer the PDO. If the 
transmission type is 253, the CANopen device begines sampling on receiving RTR and transmits PDO 
immediately. 

 
 
c) Event-drive *Note1 
 PDO can be transmitted every time when CANopen device internal event occurrence. Event 
definition can be specified in the devide profile and application profile. 

      * The XGB CANopen module processes 254 and 255 equally, and transmits when device value 
 is changed. 

 
Transmission 
Type Value 

Description 

0 Synchronous, acyclic 

1-240 
Synchronous, transmission periodically when the SYNC of the transmission type value 
is received 

241~251 Reserved 
252 Only when RTR is received (RTR-only), synchronous 
253 Only when RTR is received (RTR-only), event driven 
254 Event-driven, Manufacturer specific 

255 
Event-driven, Manufacturer specific. 
Device profile and application profile specific. 

 
(4) RPDO transmission type  

In the table below, the term synchronous means that the CANopen device applies the received data to the 
reception of the next SYNC object. Event-driven means that PDO can be received whenever, and that the 
CANopen device applies received data immediately.  
 

Transmission Type Value Description 
0-240 Synchronous 

241~253 Reserved 
254 Event-drive (manufacturer specific) 
255 Event-drive (device profile and application profile specific) 

 
2) Transmission type No. 

Activated only when synchronous cyclic (1-240) is selected as the transmission type, and the PDO 

transmission period is (master-side cycle period x transmission type No.). 

▶Example: master-side cycle period is 100ms, and the transmission type No. is set to 3; 

           Synchronous cyclic period = 100×3 = 300ms. I.e, data communication at every  
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3) Inhibit time 

Used when the transmission type is 254 or 255. The time is the minimum time interval for PDO transmission. When 

data exchange occurs frequently and irregularly, PDO transmission within this time from the previous PDO 

transmission is inhibited. The value is not changed as long as PDO exists in valid status. 

 
4) Event Time 

Applied when the transmission type is 254 or 255. The time is the maximum time interval for PDO 

transmission. When data exchange occurs infrequently and irregularly, PDO is transmitted after this time 

from the previous PDO transmission forcedly. 

 
Note  

The XGB CANopen module processes 254 and 255 equally, and transmits when device value is changed. 

Our own COB-ID starts from 0x681. 
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8.6  PDO mapping 
Objects can be mapped on the set up PDOs.  

 

 

8.6.1  PDO Type Filter 
Select Receive PDO or Transmit PDO for setting up. 

 

8.6.2  PDO contents 
The PDOs selected for used in the PDO setting are displayed. Indicated PDOs are mapped with objects . 

 

8.6.3  PODs Map 

Show the object recorded in the EDS. To start mapping, select an object and click the downward arrow key. For 

the meanings of the index, sub-index, parameter, and data type, see the description of the section 8.3 SDO 

Setting, 1) Object List. Size refers to bit size. For example, UNSIGNED16 refers to 16 bit size.. 

 

8.6.4  Mapped Objects 

The objects selected for mapping are displayed. To cancel mapping, select the object to delete from 

the mapped objects, and click upward arrow key. 

 



 

 

 

 
Chapter 8 Slave Setting using XG-CANopen 

 

 8-26 

 

8.7  Add slave 
Slaves can be added by two methods. The first method is to add a slave directly to the master module, and the 

second is using Auto Scan. To use the Auto Scan function, the slave must be connected to the network with the 

same baud rate and different station No.. 

 
(1) Adding at master module 

No Process Procedure 

1 

Add slave 

   

1. Select the master module and right click the mouse to select [Add Slave]. 

2. Or, in the edit window, click the master module and select [Add Slave]. 

2 

Properties  
of slaves 

  

1. Enter following items in the slave window; 

1) Station No.: enter the slave node ID. 

2) Name: enter name of the slave node 

3) Device: enter the EDS product name of the slave node.   

4) EDS: enter the EDS file path of the slave node.  

2. Click EDS call-up button and add the desired EDS.  
3. Click [OK] button. 
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No Process Procedure 

3 

Select Add to 
Master 

 

1. In the network window, the slave is added beneath the master module. 
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(2) Adding slave in Auto Scan 

 

No Process Procedure 

1 

Add Slave 

     

1. Select [Online] → [Auto Scan] 

2. Select [Online] → [Auto Scan Add Project ] 

2 

Check Slave 
Registration 

 

1. Check that the slaves are added in the project window. 
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Chapter 9 Slave Module(XBL-CSEA) Setting using XG5000 
 

9.1  Registration of Communication Module 
To used the XGB CANopen slave I/F module(XBL-CSEA), make out the communication parameters with XG5000. 
Before preparing the parameters, register the slot of the module mounted in XG5000. The registration procedures of 
the CANopen I/F modules are as follows, according to the online or off-line status.  

 

9.1.1  Off-line Registration 

This method applies for communication module setting and preparing communication related parameters while 

not in connection with PLC. 

1) Run XG5000, select Project → New Project, or click (    ) icon. 

2) Enter project name in the project name field, select PLC series and CPU type of the selected PLC in the 

PLC type. 

 

3) In the Project Window of the XG5000, right click on Unspecified Network and select [Add Item]-

[Communication module]. Click [Add Module] and set the type, base and slot of CANopen I/F module to 

registration. 
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9.1.2   Online Registration  

To register communication module using XG5000 in online status, conduct the steps No. 1 and 2 of the off-line 

registration and conduct following steps. 

 
1) Enter project name in the project name field, select PLC series type and select the PLC CPU type in the 

CPU type 

2) If unable to connect, check the connectivity with the PLC, select [Online →Connect Setting] or 

click (     ) icon to select connection method. Available connection methods are RS-232C cable, 

USB cable, Ethernet module and EtherNet/IP module. 

3) When normally connected, the submenus of the online menus are enabled. 

4)  To check up the module currently mounted in the basic unit,  

select [Online →Diagnosis →Read IO Information]. And all the communication modules are searched 

and displayed in the project window. If the modules registered offline differ from the information of the 

currently connected PLC, or differ from the type of the communication module worked in the previous 

project, check the change in addition with the above message.  

 
5) The list of the communication modules installed in the product is created in the project window. 
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9.1.3  Reading Parameters from PLC  

The default parameters stored in PLC can be loaded with following procedures. 

1) From file menu, select Open from PLC. 

 
 

2) Set up access method and step click [Connect] or [OK]. 
3) The default parameters stored in the PLC is loaded PLC. 
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9.2  Basic Parameter Setting 

9.2.1  Basic Parameter Setting 

The method and procedures of setting up the basic parameters of the CANopen slave are as follows; 

1) In the project window, select CANopen Slave and double click it. 

 

 
 

2) Enter station No. Available station numbers are 1~127. 
3) Enter communication speed. Same as the XGB CANopen master, following 9 baud rates are supported 

10K, 20K, 50K, 100K, 125K, 250K, 500K, 800K, 1Mbit/s  
4) Set up the starting address and size of the area to be read. The starting address and size are all word size  
5) Set up the starting address and size of the storage area. The starting address and size are all word size. 
   Available size are 8~256 words. 
 

 
Note  

 In the slave EDS, 256 objects can be set up. Therefore, all 256 objects can be set up when setting up the master.  
However, the basic unit and communication module exchanges data by the size set up in the basic parameter.  
As such, when the setting is less than 256, the master and slave can conduct PDO mapping and exchange  
data properly. 
However, in case of RPDO, it is not reflected on the device of the basic unit, and in the case of TPDO,  
the value changed in the basic unit is not transferred to the slave module and not reflected on the master. 
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9.2.2  Relationship between PLC Address and CANopen Object 
If the basic parameters are set up as follows, the relationship between the PLC address and XGB CANopen 
slave object can be checked up with the Detail View of Basic Setting  
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9.2.3  Writing Parameters 
Apply the basic settings of the slave by selecting [Online] → [Write]. 
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Chapter 10 Examples 
10.1  Examples of System Configuration 

10.1.1  System Configuration 
The following example is for a configuration with the CANOpen master module (XBL-CSEA) and slave module 
(XBL-CSEA) and the slave module from another manufacturer (Schneider OTB1C0DM0LP). The layout is 
shown in the figure below. Product settings are presented in the table below. 
 

 

Type XBL-CMEA XBL-CSEA OTB1C0DM0LP 
Station No. 1 10 20 
Baud rate 1Mbps 1Mbps 1Mbps 

No. of PODs - 
RPDO: 4  
TPDO: 4 

RPDO: 1(1byte) 

Transmission period (ms) 100 100 100 
Transmission type Synchronous cyclic Synchronous cyclic Synchronous cyclic 
Error control setting Heartbeat Heartbeat Heartbeat 
Produce time 200ms 200ms 200ms 

Device allocation 
TPDO: M0 
RPDO: D0 

TPDO: M0 
RPDO: D0 

- 

 

10.1.2  Description Operation 
1) CANOpen master I/F Module(XBL-CMEA)  

(1)  16 words (M49~M64) data are sent to #10 station  
(2)  Receive 16 word of data from #10 station and store them in the D0~D15 area 
(3)  Send 1byte which is No. zero in the M65 area to #20 station  

2) CANOpen slave I/F module(XBL-CSEA)  
(1)  Receive 16 word of data from #1 master station and store them in the D0~D15 area 
(2)  Send the data of M0~M15 to the #1 master station  

3) Schneider slave module (OTB1C0DM0LP)  
(1)  Receiver 1 byte data from the #1 master station 
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10.1.3  Parameter Setting 
1) CANOpen Slave setting(XBL-CSEA, OTB1C0DM0LP)  

No Process Procedure 

1 

XBL-CSEA 
parameter setting 

 

1. Execute XG5000.  
2. Set up the project name and applied PLC type. and click [OK] button. 

2 

XBL-CSEA  
parameter setting 
(1) Basic Setting 

 

1. Offline setting 

(1) Right click on Unspecified Network of project window → Add Item → Communication Module → Add Module → 

Select XBL-CSEA 

(2) in the communication module set up, select the CANopen Slave and mounted slot, and click [OK] 

2. Online mode setting 
(1) Select File → Open form PLC, or execute XG5000, create a new project,  

and select Online → Diagnosis → Read I/O Information → I/O Sync 
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3 

XBL-CSEA  
parameter setting 
(2) Basic Setting 

 

1. Double click CANOpen Slave 
2. As suggested in the system configuration, enter the station No., baud rate TPDO, RPDO area and size. 

No Process Procedure 

4 

Write Parameter 

 

1. Select Online → Write. 

2. Click [OK] button. 

5 OTB1C0DM0LP 

1. Set up parameters referring to OTB1C0DM0LP datasheet and user manual. 
(1) Station No. set up: open the front cover of OTB1C0DM0LP and set the Address switch to  

No. 20. 
(2) baud rate set up: Set the BAUD RATE rotary switch to No. 7. 

- No. 7: 1000kbps 
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2) CANOpen master I/F module (XBL-CMEA)   

 
 

No Process Procedure 

1 

Master module 
registration 

     
<Example of master module registration by I/O synchronization> 

   

 

<Example of master module registration by I/O parameter addition> 
1. Master module registration by I/O synchronization 
1) Mount the XBL-CMEA to basic unic 
2) Connect XG5000 and select Online → Diagnosis → I/O Information → I/O Sync  
3) Confirm that CANOpen Network is created in the XG5000 parameter.  

2. Master module registration by I/O parameter addition 
1) Execute XG5000 and double click the I/O parameter in the project window. 
2) Select CANOpen Master in the slot where the module is mounted, and click Confirm 
3) Confirm that CANOpen Network is created in the XG5000 parameter. 
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No Process Procedure 

2 

Executing  
XG-CANopen 

   

<CANOpen Network> 

 
<XG-CANopen Window> 

1. In the project window, click CANOpen Network to execute XG-CANopen. 

3 
Adding slave a module 

    

1. In the XG-CANopen project window, select CANOpen_Master, right click the mouse and select Add Slave Module. 

 -Set up station No. and name EDS path to register XBL-CSEA and OTB1C0DM0LP 



 

 

 

 
Chapter 10 Examples 

 

 10-6 

 
 

No Process Procedure 

4 

Master module 
parameter setting  

(1) Properties 

 

1. In the XG-CANopen project window, double click CANOpen_Master and select register information. 
2. Set up the station No., baud rate, cycle, PLC reception/transmission are as suggested  
in the system configuration. 
3. Make sure to click Apply after entering the setting values. 

5 

Master module 
parameter setting  

(2) Error Control Setting 

 

1. Set up the master-side Heartbeat producer type and slave producer type. 
2. Select Heartbeat as the protocol from the slave error control list. 

6 

XBL-CSEA setting 
(1) PDO Setting 

 

 

1. In the XG-CANopen project window, double click the XBL-CSEA added in above paragraph 3 and select PDO set up. 

2. Select 4 TPOD and 4 RPDO suggested in the system configuration. 

-The T/RPDO of the XBL-CSEA are arranged in the order of TPDO1~64 after P RPOD1~64. 
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No Process Procedure 

7 

XBL-CSEA setting (1) 
PDO Setting 

 
1. In the PDOs setting, set up the transmission type and transmission type numbers for each TPOD and RPDO,  

as suggested in the system configuration. 
(1) Transmission type: set to Synchronous cyclic type 
(2) Transmission type No.: for Synchronous cyclic, data are transmitted after the master cycle periodic signal  

is generated, set up with 1. 
 - After set up Synchronous cyclic, if the transmission type No. is 2, data communication starts after  

2 cycle signals of the master. 

8 

XBL-CSEA setting (2) 
PDO Mapping 

  

1. Click the PDO mapping. 

2. In the POD type filter, select RPDO, and in the PDO contents, select No. 1 RECEIVE PDO PARAMETER. 

3. From the objects available for mapping, double click the parameter of the index to be used, or click ↓ to  

map the parameter. 

- In the example, %QW1~4 is selected for convenience 

4. In the same methods as of above clauses 2 and 3, map the 2~4 RECEIVE PDO PARAMETER. 

  - the entire mapping parameter is %QW1~16 

5. In the POD type filter, select TPDO, and in the PDO contents, select No. 1 TRANSMIT PDO PARAMETER. 

6. In the same method as of above clause 2, map the 1~4 TRANSMIT PDO PARAMETER. 
- the entire mapping parameter is %IW1~16 
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No Process Procedure 

9 

OTB1C0DM0LP setting  
(1) PDO Setting 

 

 

1. In the XG-CANopen project window, double click the OTB1C0DM0LP added in above paragraph 3  

and select PDO set up 

- for the case of the module, only 8 bit output module is installed without adding I/O. 

2. In the PDOs setting, enter transmission type and transmission type No. 

 (1) Transmission type: set to Synchronous cyclic type 

(2) Transmission type No.: as described in the clause 10, set the type No. to 1 for operation at 100ms cycle time..  

10 

OTB1C0DM0LP setting  
(2) PDO Mapping 

 

1. Click the PDO mapping. 

2. In the POD type filter, select RPDO, and in the PDO contents, select RECEIVE PDO PARAMETER. 

3. From the objects available for mapping, double click the parameter of the index to be used, or click ↓  

to map the parameter.  

- Since OTB1C0DM0LP uses only 8 bit output, select b bit write parameter which is the No. 1 of the sub-index 

 of the index No. 6200 for the RPDO (Receive PDO). 
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No Process Procedure 

11 

Writing 
Parameter 

 

1. Select Online → Writing 
2. Select the CANOpen master set up with parameter, and click Confirm. 

12 

Enable Link 

 

1. Select Online → Enable Link 

2. Check the No. of the link set up with parameter, and click Write. 

- The link No. must be selected in the order to the communication module installation.  
Ex) If another communication module is installed before CANOpen master module, set up the link No. with 3. 
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10.1.4  Operation Check 
1) Network state check using diagnosis function 

 

No Process Procedure 

1 

Diagnosis Variable 

 

1. Double click the master module of the XG-CANopen. 
2. Click the diagnosis variable table 
3. Select Online → Start Monitor 
4. Check up the states of the master module and slave module referring to the monitor values and explanation. 

2 

Auto Scan Service 

 
1. Select Online → Auto Scan. 
2. The entire network condition can be checked up with the report of the Auto Scan. 
3. To check the status of each slave, select the slave, right click the mouse to check specification error history and slave 

service status. 
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A.1 Terms 
 

 
1. CAN (Controller Area Network) 

The open-type field bus specified in ISO11898 to enable communication between various heterogeneous devices of 
different manufacturers. 
 

2. CANopen 
A description language for communication on CAN bus, independent of devices and manufacturers. It is an application 
layer. 
 

3. CiA (CAN in Automation): a group conducting standardization of CAN and CANopen 
 

4.  COB 
The basic communication object on the CAN network. All the data are communicated using COB. 
 

5.  COB ID 
The unique numbers designating the COBs on the CAN network, consists of station number and functional code.  
This determines the communication priority of the COB. 
 

6. DCF (Device Configuration File) 
The file in EDS structure containing the configuration information (baud rate, station No., PDO mapping, etc.) determined 
by project. 
 

7. EDS (Electronic Data Sheet) 
The standardization file containing the communication method of the device and parameter description. 
 

8.  Heartbeat 
The message transmitted from a device at preset cycles to notice other devices of the connection. 
 

9.  NMT (Network Management) 
A component of the CANopen communication profile, which conducts the initialization of the network and device, start-up, 
termination and monitoring of the device. 
 

10. Node guarding: the periodic action of the master monitoring the communication connection of slave 
 

11. OD (Object Dictionary) 
The list of all the values and functions of the parameters of the device. Each entry can be accessed using index (16 bit) 
and sub-index (8 bit). 
 

12. Parameter: the data and value of device which can be set up by users. 
 

13. PDO (Process Data Object) 
A practical means for transmitting process data. It is a communication object having high priority, transmitted by 1 
producer and received by 1 or more stations of consumers.  One PDO can have up to 8 bytes and unique COB ID, and 
does not require the acknowledgement from the receiver station. The meaning of the transmitted data is determined by 
COB ID and PDO Mapping. The PDO priority and operating mode are determined by communication parameter setting. 
PDO producer and consumer must have the same data structure to process PDO.  The data structure of the Producer 
and consumers are determined by TPDO and RPDO, respectively.  



 

 

 

 
Appendix 

 

 A-2 

14. PDO-Mapping 
Means allocation of application object to the data field of PDO. Mapping has two methods of static and dynamic. In the 
static mapping, the objects of the PDO must be continuous, and cannot be omitted or allocated with a dummy object. 
 

15. Predefined Connection Set 
The COB ID pre-allocated with reference to the station No. and function code. The communication object by such 
predefined connection set are Node guarding/heartbeat, emergency object, sync message, time stamp, server-SDO 1, 
RPDO1~4, and TPDO1~4.   
 

16. RPDO (Receive PDO)    
PDO used for reception. 
 

17. SDO (Service Data Object) 
 A communication object used to initialize CANopen device, set up parameters, or to transmit long data records  
(e.g.: domain data), and has low priority. The entries in the object dictionary can be written and read using SDO,  
and the entry designation is performed with index and sub-index. 
 

18. Producer 
An entity crating information 
 

19. Consumer  
An entity receiving and consuming information 

 
20. Server 

The subject providing information on request 
 

21. Client 
The subject requesting information 
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A.2 Flag List  
 

A.2.1 Special Relay (F) List                  
 

Word Bit Variable  Function  Description  

F000~1 

- _SYS_STATE Mode and State Displays the Mode and Run State of PLC  
F0000 _RUN RUN Run State  
F0001 _STOP STOP Stop state  
F0002 _ERROR ERROR Error state. 
F0003 _DEBUG DEBUG Debug State  
F0004 _LOCAL_CON LOCAL CONTROL Local Control Mode 
F0006 _REMOTE_CON REMOTE MODE Remote Control Mode 
F0008 _RUN_EDIT_ST CORRECTING  WHILE RUN Downloading Correction Program while Run. 
F0009 _RUN_EDIT_CHK CORRECTING  WHILE RUN Internal Processing for Correction while Run  

F000A _RUN_EDIT_DONE CORRECTION COMPLETED 
WHILE  RUN Correction Completed while Run  

F000B _RUN_EDIT_END CORRECTION END WHILE RUN Correction Ended while Run  
F000C _CMOD_KEY OPERATION MODE Operation Mode Transformed by the Key 
F000D _CMOD_LPADT OPERATION MODE Operation Mode Transformed by the Local PADT 
F000E _CMOD_RPADT OPERATION MODE Operation Mode Transformed by Remote PADT 

F000F _CMOD_RLINK OPERATION 
MODE 

Operation Mode Transformed by Remote Communication 
Mode  

F0010 _FORCE_IN FORCIBLE ENTRY Forcible Entry State  
F0011 _FORCE_OUT FORCIBLE OUTPUT Forcible Output State  
F0014 _MON_ON MONITOR Executing Monitor  
F0015 _USTOP_ON STOP Stopped by Stop Function 
F0016 _ESTOP_ON ESTOP Stopped by EStop Function  
F0017 _CONPILE_MODE COMPILING Performing Compiling  
F0018 _INIT_RUN INITIALIZING Performing Initializing Task 
F001C _PB1 PROGRAM CODE 1 Program Code 1 Selected  
F001D _PB2 PROGRAM CODE 2 Program Code 2 Selected  
F001E _CB1 COMPILE CODE1 Compile Code 1 Selected  
F001F _CB2 COMPILE CODE 2 Compile Code 2 Selected  

F002~3 

 _CNF_ER SYTEM ERROR Reports Serious Failure State of the System 
F0021 _IO_TYER MODULE  TYPE ERROR Module Type does not corresponds. 
F0022 _IO_DEER MODULE REMOVAL ERROR Module Removed  
F0024 _IO_RWER MODULE IN/OUTPUT ERROR Problems occurred in to Module In/Output 

F0025 _IP_IFER 
MODULE INTERFACE 

ERROR 
Problems occurred in the special/communication 
module interface 

F0026 _ANNUM_ER EXTERNAL DEVICE ERROR Serious Errors detected from External Devices  
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Word Bit Variable  Function  Description  

F002~3 

F0028 _BPRM_ER BASIC PARAMETER Errors in Basic Parameter  
F0029 _IOPRM_ER IO PARAMETER Errors with IO Configuration Parameter  

F002A _SPPRM_ER SPECIAL MODULE 
PARAMETER Special Module Parameter is in Abnormal State  

F002B _CPPRM_ER COMMUNICATION MODULE 
PARAMETR Communication Module Parameter is in Abnormal State 

F002C _PGM_ER PROGRAM ERROR Errors in Program  
F002D _CODE_ER CODE ERROR Errors in Program Code  
F002E _SWDT_ER SYSTEM WATCH DOG Scan Watchdog Operated  
F0030 _WDT_ER SCAN WATCHDOG Scan Watchdog Operated  

F004 

- _CNF_WAR SYSTEM WARNIGN Reports on the Light Errors of the System  
F00041 _DBCK_ER BACKUP ERROR Problem Occurred in Data Back Up 

F00043 _ABSD_ER OPERATION 
ERROR STOP Stops due to Abnormal Operation  

F00046 _ANNUM_WAR EXTERIAL  DEVCIE ERROR The Light Error of the External Device Detected  

F00048 _HS_WAR1 HIGH  SPEED 
LINK1 High Speed Link  – abnormal 

F00049 _HS_WAR2 HIGH  SPEED 
LINK2 High Speed Link  – abnormal 

F0054 _P2P_WAR1 P2P 
PARAMETER 1 P2P – abnormal  

F0055 _P2P_WAR2 P2P 
PARAMETER 2 P2P – abnormal  

F0056 _P2P_WAR3 P2P 
PARAMETER 3 P2P – abnormal  

F005C _CONSTANT_ER 
FIXED 

PERIOD 
ERROR F 

Fixed Period Errors  

F009 

- _USER_F USER CONTACING POINT User Usable Timer  
F0090 _T20MS 20ms 20ms Periodic Clock 
F0091 _T100MS 100ms 100ms Periodic Clock  
F0092 _T200MS 200ms 200ms Periodic Clock  
F0093 _T1S 1s 1s Periodic Clock  
F0094 _T2S 2s 2s Periodic Clock  
F0095 _T10S 10s 10s Periodic Clock  
F0096 _T20S 20s 20s Periodic Clock  
F0097 _T60S 60s 60s Periodic Clock  
F0099 _ON ALWAYS - ON Always On – State Bit 
F009A _OFF ALWAYS  - ON Always Off – State Bit  
F009B _1ON 1 SCAN - ON 1st Scan Only On –State  
F009C _1OFF 1 SCAN -OFF 1st Scan Only Off –State  
F009D _STOG ANTi - CLOCK Every Scan Anti –Clocked  
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Word Bit Variable  Function  Description  

F0010 

- _USER_CLK USER-CLOCK User Set-up Available Clock  

F0100 _USR_CLK0 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan  0 

F0101 _USR_CLK1 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan  1 

F0102 _USR_CLK2 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan  2 

F0103 _USR_CLK3 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan 3 

F0104 _USR_CLK4 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan 4 

F0105 _USR_CLK5 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan 5 

F0106 _USR_CLK6 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan 6 

F0107 _USR_CLK7 DEGIGNATED SCAN REPEATED On/Off Clock as much as Designated Scan 7 

F0011 

- _LOGIC_RESULT LOGIC RESULTS Displays Logic Results  

F00110 _LER CALCULATION ERROR On during 1 Scan when Errors made to Calculation 

F00111 _ZERO ZERO FLAG On if Calculation Result is 0 

F00112 _CARRY CARRY FLAG On if Carry occurred during Calculation 

F00113 _ALL_OFF ALL OUTPUT OFF On if All Outputs are OFF  

F00115 _LER_LATCH CALCULATION ERROR 
LATCH On Maintained when Errors made to Calculation  

F0012 

- _CMP_RESULT COMPARISION RESULTS Display Comparison Results  

F0120 _LT LT  FLAG On if “ Less Than “  

F0121 _LTE LTE  FLAG On if “The Same or Less Than”  

F0122 _EQU EQU  FLAG On if “The Same ”  

F0123 _GT GT  FLAG On if “Larger Than ”  

F0124 _GTE GTE  FLAG On “Larger Than or The Same ”  

F0125 _NEQ NEQ  FLAG On if “Not The Same ”  

F014 - _FALS_NUM FALS NUMBER Displays the Number of FALS 

F015 - _PUTGET_ERR0 PUT/GET ERROR 0 Main Base PUT / GET ERROR 

     

F023 - _PUTGET_NDR0 PUT/GET COMPLETED 0 Main Base PUT / GET COMPLETED  

F044 - _CPU_TYPE CPU TYPE Displays the Information on CPU Type 

F045 - _CPU_VER CPU VERSION Displays CPU Version  

F046 - _OS_VER O/S VERSION Displays O/S Version  

F048 - _OS_DATE O/S DATE Displays O/S Distribution Date  

F050 - _SCAN_MAX MAXIMUM 
SCAN  TIME Displays Maximum Scan Time  

F051 - _SCAN_MIN MINIMUM SCAN TIME Displays Minimum Scan Time  

F052 - _SCAN_CUR CURRENT SCAN TIME Displays Current Scan Time. 

F0053 - _MON_YEAR MONTH /YEAR Month, Year Data of PLC 

F0054 - _TIME_DAY HOUR / DATE Hour, Date Data of PLC 

F0055 - _SEC_MIN SECOND / MINUTE Second, Minute Data of PLC 

F0056 - _HUND_WK 100 YEARS / DAY 100 Years , Minute Data of PLC 



 

 

 

 
Appendix 

 

 A-6 

Word Bit Variable  Function  Description  

F0057 

- _FPU_INFO Not used  

F00570 _FPU_LFLAG_I Not used  

F00571 _FPU_LFLAG_U Not used  

F00572 _FPU_LFLAG_O Not used  

F00573 _FPU_LFLAG_Z Not used  

F00574 _FPU_LFLAG_V Not used  

F0057A _FPU_FLAG_I Not used  

F0057B _FPU_FLAG_U Not used  

F0057C _FPU_FLAG_O Not used  

F0057D _FPU_FLAG_Z Not used  

F0057E _FPU_FLAG_V Not used  

F0057F _FPU_FLAG_E IRREGULAR VALUE ENTRY Reports when Entering Irregular Value  

F0058 - _ERR_STEP ERROR 
STTEP Stores Error Step. 

F0060 - _REF_COUNT REFRESH Increases if Module Refresh Performed  

F0062 - _REF_OK_CNT REFRESH OK Increases if Module Refresh is in Normal State  

F0064 - _REF_NG_CNT REFRESH NG Increases if Module Refresh in Abnormal State  

F0066 - _REF_LIM_CNT REFRESH LIMIT Increases if Module Refresh in Abnormal State  (Timeout ) 

F0068 - _REF_ERR_CNT REFRESH ERROR Increases if Module Refresh in Abnormal State  

F0070 - _MOD_RD_ERR_CNT Not used  

F0072 - _MOD_WR_ERR_CNT Not used  

F0074 - _CA_CNT Not used  

F0076 - _CA_LIM_CNT Not used  

F0078 - _CA_ERR_CNT Not used  

F0080 - _BUF_FULL_CNT BUFFUR FULL Increases if CPU Internal Buffer FULL 

F0082 - _PUT_CNT PUT COUNT Increases if Performing PUT. 

F0084 - _GET_CNT GET COUNT Increases if Performing GET. 

F0086 - _KEY CURRENT KEY Displays the Current State of Local Key. 

F0088 - _KEY_PREV PREVIOUS KEY Displays the Previous State of Local Key 

F0090 - _IO_TYER_N INCONSISTENT SLOT Displays Module Type – Inconsistent Slot No. 

F0091 - _IO_DEER_N REMOVAL SLOT Displays Slot No. where Module Removal Occurred  

F0093 - _IO_RWER_N RW ERROR SLOT Displays Module Read/Write –Error Slot No.   

F0094 - _IP_IFER_N I/F ERROR SLOT Displays Interface Error Slot No.   

F0096 - _IO_TYER0 MODULE TYPE 0 ERROR Main Base - Module Type Error  

F0104 - _IO_DEER0 MODULE REMOVAL 0  ERROR Main Base Module Removal Error  

F0120 - _IO_RWER0 MODULE RW 0 ERROR Main Base - Module Read/Write Error 

F0128 - _IO_IFER_0 MODULE  I/F 0  ERROR Main Base Module - Interface Error 

F0140 - _AC_FAIL_CNT POWER SHUT-OUT 
FREQUENCY Stores the Frequency that Power has been Shut out. 
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Word Bit Variable  Function  Description  

F0142 - _ERR_HIS_CNT ERROR OCCURRENCE 
FREQUENCY Stores the Frequency that Error s were Made  

F0144 - _MOD_HIS_CNT MODE CONVERSIO N 
FREQUENCY Stores the Frequency that the Mode has been Converted  

F0146 - _SYS_HIS_CNT HISTORY OCCURRENCE 
FREQUENCY Stores the Frequency that the System History Occurred. 

F0148 - _LOG_ROTATE LOG ROTATE Stores Log Rotate Information  

F0150 - _BASE_INFO0 SLOT INFORMATION  0 Main Base Slot Information  

F200 

- _USER_WRITE_F USABLE CONTACTING POINT Contacting Point Usable in Program  

F2000 _RTC_WR RTC RW Writes and Read Data to RTC 

F2001 _SCAN_WR SCAN WR Scan Value Initialization  

F2002 _CHK_ANC_ERR EXTERNA L 
SERIOUS FAILURE REQUEST Requires Serious Failures from External Devices  

F2003 _CHK_ANC_WAR EXTERNAL WARNING REQUEST Requests  to Detect Light Failures from External Devices 

F201 
- _USER_STAUS_F USER CONTACTING POINT User Contacting Point  

F2010 _INIT_DONE INTIALIZATION COMPLETED Displays Initialization Task Performance Completed  

F202 - _ANC_ERR EXTERNAL SERIOUS FAILURE 
INFORMATION Displays Serious Failures Information of External Devices  

F203 - _ANC_WAR EXTERNAL LIGHT FAILURE 
WARNING Displays the Light Failures Information of External Devices 

F210 - _MON_YEAR_DT MONTH / YEAR Clock  Information Data (Month / Year) 

F211 - _TIME_DAY_DT HOUR / DAY Clock Information Data ( Hour / Day ) 

F212 - _SEC_MIN_DT SECOND / MINUTE Clock Information Data (Second  / Minute ) 

F213 - _HUND_WK_DT 100 YEARS  / DAY Clock Information Data( 100 Years / Day ) 

 



 

 

 

 
Appendix 

 

 A-8 

 
(2) Common area   

 
Communication flag according to P2P service setting 
In case of XGB, P2P parameter 1~3, P2P block 0~31 
 

Device IEC type Key word Type Description 

L5120 %LX8192 _P2P1_NDR00 Bit P2P Parameter 1 block 0 service normal end 

L5121 %LX8193 _P2P1_ERR00 Bit P2P Parameter 1 block 0 service abnormal end 

L513 %LW513 _P2P1_STATUS00 Word 
When P2P Parameter 1 block 0 service abnormal end, 
indicates error code.  

L514 %LD257 _P2P1_SVCCNT00 Double Word 
Indicates P2P Parameter 1 block 0 service normal 
execution count 

L516 %LD258 _P2P1_ERRCNT00 Double Word 
Indicates P2P Parameter 1 block 0 service abnormal 
execution count 

L5180 %LX8288 _P2P1_NDR01 Bit P2P Parameter 1 block 1 service normal end 

L5181 %LX8289 _P2P1_ERR01 Bit P2P Parameter 1 block 1 service abnormal end 

L519 %LW519 _P2P1_STATUS01 Word 
When P2P Parameter 1 block 1 service abnormal end, 
indicates error code.  

L520 %LD260 _P2P1_SVCCNT01 Double Word 
Indicates P2P Parameter 1 block 1 service normal 
execution count 

L522 %LD264 _P2P1_ERRCNT01 Double Word 
Indicates P2P Parameter 1 block 1 service abnormal 
execution count 

L524~L529 
%LW524~ 
%LW529 

- Word P2P parameter1 block 2 service  

L530~L535 
%LW530~ 
%LW535 

- Word P2P parameter1 block 3 service 

L536~L697 
%LW536~ 
%LW697 

- Word P2P parameter1 block 4~30 service 

L698~L703 
%LW698~ 
%LW703 

- Word P2P parameter1 block 31 service 
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A.2.2 Network Register (N) List 
  

This chapter describes on communication network register (P2P parameter: 1~3, P2P block: 0~31) 
 

Device IEC type Key word Type Description 

N000 %NW000 _P1B00SN Word Saves P2P parameter1 block 00‘s partner station number. 

N0001~0004 %NW0001~0005 _P1B00RD1 Word Saves Saves P2P parameter1 block 00 Read area device 1 

N005 %NW006 _P1B00RS1 Word Saves Saves P2P parameter1 block 00 Read area size 1 

N0006~0009 %NW0007~0011 _P1B00RD2 Word Saves Saves P2P parameter1 block 00 Read area device 2 

N010 %NW012 _P1B00RS2 Word Saves Saves P2P parameter1 block 00 Read area size 2 

N0011~0014 %NW0013~0017 _P1B00RD3 Word Saves Saves P2P parameter1 block 00 Read area device 3 

N015 %NW018 _P1B00RS3 Word Saves Saves P2P parameter1 block 00 Read area size 3 

N0016~0019 %NW0019~0023 _P1B00RD4 Word Saves Saves P2P parameter1 block 00 Read area device 4 

N020 %NW024 _P1B00RS4 Word Saves Saves P2P parameter1 block 00 Read area size 4 

N0021~0024 %NW0025~0029 _P1B00WD1 Word Saves Saves P2P parameter1 block 00 Save area device 1 

N025 %NW030 _P1B00WS1 Word Saves Saves P2P parameter1 block 00 Save area size 1 

N0026~0029 %NW0031~0035 _P1B00WD2 Word Saves Saves P2P parameter1 block 00 Save area device 2 

N030 %NW036 _P1B00WS2 Word Saves Saves P2P parameter1 block 00 Save area size 2 

N0031~0034 %NW0037~0041 _P1B00WD3 Word Saves Saves P2P parameter1 block 00 Save area device 3 

N035 %NW042 _P1B00WS3 Word Saves Saves P2P parameter1 block 00 Save area size 3 

N0036~0039 %NW0043~0047 _P1B00WD4 Word Saves Saves P2P parameter1 block 00 Save area device 4 

N040 %NW0048 _P1B00WS4 Word Saves Saves P2P parameter1 block 00 Save area size 4 

N0041~0081 %NW0049~0097 - Word P2P parameter 1 block 01 Save area 

N0082~0122 %NW0098~0146 - Word P2P parameter 1 block 02 Save area 

N0123~1311 %NW0147~1567 - Word P2P parameter 1 block 03 ~ 31 Save area 

N1312~2623 %NW1568~3135 - Word P2P parameter 2 Save area 

N2624~3935 %NW3136~4703 - Word P2P parameter 3 Save area 

 
 
 
 

Note  
Network register is Read Only device in the XGB. 

 

 



 

 

 

 
Appendix 

 

 A-10 

  

A.3 External Dimension  
 

 [Dimension Unit : mm] 

• XBL-CMEA and XBL-CSEA have the same dimension 

 

 
 

 
 

 



 

 

 

 

 

Warranty and Environmental Policy 
 

 

     

 
 

Warranty 
 
 
1. Warranty Period 

 The product you purchased will be guaranteed for 18 months from the date of manufacturing.  
 
2. Scope of Warranty 
   Any trouble or defect occurring for the above-mentioned period will be partially replaced or repaired. However, please note the following 

cases will be excluded from the scope of warranty.  
  

(1) Any trouble attributable to unreasonable condition, environment or handling otherwise specified in the manual,  
(2) Any trouble attributable to others’ products, 
(3) If the product is modified or repaired in any other place not designated by the company,  
(4) Due to unintended purposes 
(5) Owing to the reasons unexpected at the level of the contemporary science and technology when delivered.  
(6) Not attributable to the company; for instance, natural disasters or fire 
 

 
3.  Since the above warranty is limited to PLC unit only, make sure to use the product considering the safety for system configuration or 

applications.  
 
 
 

 

Environmental Policy 
 
 
     LSIS Co., Ltd supports and observes the environmental policy as below.  
 
 
 
  

 
LSIS considers the environmental preservation 
as the preferential management subject and 
every staff of LSIS use the reasonable 
endeavors for the pleasurably environmental 
preservation of the earth.   

 
 
     

LSIS’ PLC unit is designed to protect the 
environment. For the disposal, separate 
aluminum, iron and synthetic resin (cover) from 
the product as they are reusable.   

Environmental Management About Disposal 



 

 

■ HEAD OFFICE 
  LS Tower, 127, LS-ro, Dongan-gu, Anyang-si,Gyeonggi-do, 431-848, Korea 

Tel: 82-2-2034-4870 Fax: (82-2)2034-4648 e-mail: cshwang@lsis.biz 
■ LS Industrial Systems Tokyo Office _ Tokyo, Japan 

Address: 16FL. Higashi-Kan. Akasaka Twin Tower 17-22,  
   Akasaka.Monato-ku Tokyo 107-8470. Japan 
   Tel : 81-3-3582-9128/Fax : 81-3-3582-2667 e-mail : jschuna@lsis.biz                      
■ LS Industrial Systems(ME) FZE _ Dubai, U.A.E. 

 Address : Jafza View Tower Lob 19, Room 205 Along Sheikh Zayed  
 Road Jebel Aali Free Zone Dubai, United Arab Emirates 
Tel : 971-4-886-5360/Fax : 971-4-886-5361 e-mail : jungyongl@lsis.biz                               

■ LS Industrial Systems Shanghai Office _ Shanghai, China 
   Address : Room E-G. 12FL Hiamin Empire Plaza. No.726. West. 
   Yan'an Road Shanghai 200050. P.R. China e-mail : liyong@lsis.com.cn 

Tel : 86-21-5237-9977(609)/Fax : 89-21-5237-7189                 
■ LS Industrial Systems Beijing Office _ Beijing, China  

Address : B-Tower 17FL. Beijing Global Trade Center B/D. No. 36. 
East BeisanHuan-Road. DongCheng-District. Beijing 100013. P.R. China 

   Tel : 86-10-5825-6027(666)/Fax : 86-10-5825-6028 e-mail : xunmj@lsis.com.cn 
■ LS Industrial Systems Guangzhou Office _ Guangzhou, China 

Address : Room 1403.14FL. New Poly Tower. 
2 Zhongshan Liu Road.Guangzhou.P.R China 
Tel : 86-20-8328-6754/Fax : 86-20-8326-6287 e-mail : chenxs@lsis.com.cn 

 
 
 
 
  

 

■ LS Industrial Systems Chengdu Office _ Chengdu, China 
Address : 12FL. Guodong Buiding. No.52 Jindun  
Road Chengdu.610041. P.R. China 
Tel : 86-28-8612-9151(9226)/Fax : 86-28-8612-9236 e-mail : comysb@lsis.biz  

■ LS Industrial Systems Qingdao Office _ Qingdao, China 
Address : YinHe Bldg. 402 Room No. 2P Shandong Road, 
Qingdao-City,Shandong-province 266071, P.R. China 
Tel : 86-532-8501-6068/Fax : 86-532-8501-6057 e-mail : wangzy@lsis.com.cn 

■ LS Industrial Systems Europe B.V. , Netherlands 
    Address : 1st. Floor, Tupolevlaan 48, 1119NZ, Schiphol-Rijk, The Netherlands 

Tel : +31 (0)20 654 1420/Fax : +31 (0)20 654 1429 e-mail : junshickp@lsis.biz 
■ Wuxi LS Industrial Systems Co., Ltd _ Wuxi, China 

Address : 102-A. National High & New Tech Industrial Development Area.  
Wuxi. Jiangsu. 214028. P.R. China 
Tel : 86-510-8534-6666/Fax : 86-510-8534-4078 e-mail : caidx@lsis.com.cn 

■ Dalian LS Industrial Systems Co., Ltd. _ Dalian, China  
Address : No. 15. Liaohexi 3-Road. Economic and Technical Development zone. 

    Dalian 116600. China 
Tel : 86-411-273-7777/Fax : 86-411-8730-7560 e-mail : cuibx@lsis.com.cn 

■ Homepage 
http://eng.lsis.biz           

 
 
  
 

※ LSIS constantly endeavors to improve its product so that 
   information in this manual is subject to change without notice. 
 

ⓒ LSIS Co., Ltd 2010  All Rights Reserved. 
 

10310001245 

2015. 02 

LS values every single customers. 

Quality and service come first at LSIS.  

Always at your service, standing for our customers. 

 

http://eng.lsis.biz 
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